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"If I've learned anything from The Dave School, it would be
the value of hard work, determination and the importance
of having a strong passion for doing something you love. At
the end of the day, coming to The DAVE School was one of
the best decisions I've made in my life and | would implore
any other aspiring 3D Artist to do the same.”
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WELCOME

Take your mech models
to the next level

This issue we’ve gathered together a group
of amazing artists to share their advice for
designing, modelling and rendering robots
and mechs on page 36. Also, beginning on
page 30 our team of expert artists answer
SUBSCRIBE ~ your mech-related CG art queries. Plus, turn

Subscribe to 3D World to page 48 to discover how to create this
and get both the print . .
and digitaleditions.  1Ssue’s mech cover. Using 3ds Max, Mudbox
Turn to page 46 for . .
the latest offers! and Corona Renderer, our cover artist Tomi

Viisinen shares his pro workflow to model,
texture and render a battle-damaged mech.
If you like what you read this issue, why not
take things a step further and subscribe to
our new Pro Subs club offer; members get

exclusive news, discounts and offers as well
as 3D World delivered both in print and
digitally! See page 53 for details.

MASTER QUIXEL 2

Get started in the latest

texture app with our pro
training on page 54

Ian Dean, editor

ian.dean@futurenet.com

N EMALL WEBSITE

H 3dworld@futurenet.com 3dworld.creativeblog.com
FACEBOOK TWITTER
www.facebook.com/3dworldmagazine @3DWorldMag
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DIGITAL month’s 3D World
SUBSCRIPTIONS

Get the latest magazine for
free in our current offer or
download a back issue on
iPad and iPhone today!
www.bit.ly/3dworld-app

6 FREE DOWNLOADS

Get your hands on 12GB of assets
via our Vault download system
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FEATURE
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Expert artists share their techniques
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Design, model and render a tank-
inspired walking mech

54 GET STARTED WITH
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Master the tips to improve your
normal maps and texture detail

54 GET STARTED IN QUIXEL 2 6DRENDER A STILLLIFE SCENE

Top tips to master the latest texture a Bhaumik Patel shows how to create
pup PP and apply texture maps

62 CREATE DETAILED FOLIAGE

Use 3ds Max plug-ins to create

detailed vegetation for arch-viz

70 MASTER PERSONALITY IN
3D ILLUSTRATIONS

Hannah Kang's tips for adding
personality to your 3D art

76 CREATE TRUE-TO-NATURE
TREES IN BLENDER

Master The Grove plug-in to grow
realistic trees

78 DESIGN A DYNAMIC
RENAISSANCE DRESS

Camille Kleinman shares her process
using Marvelous Designer 5

48 MASTER MECH MODELLING

Tomi Vdisanen shows you how to create a tank-inspired walking mech

62 CREATE DETAILED FOLIAGE 70 IMPROVE YOUR SCULPTS 78 CREATE A DYNAMIC DRESS

Master detailed vegetation for arch-viz Add personality to your 3D illustration Master the Marvelous Designer 5 process

DEVELOP

86
Josh Parks talks through how to get
the most from the plug-in
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Dr lan Palmer examines the shift in
creating robots for film
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94 REVIEW: POSER PRO 11 Marta Niemczynska reveals how to use

Cirstyn Bech-Yagher trials the latest release Unity 5 to create a vitual CG studio
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The After Effects paint tool delivers
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The renderer set to dominate
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Josh Parks offers his advice for managing the plug-in’s pitfalls and solutions Mike Griggs reviews the impressive renderer Engine’s Dave Morley into VFX
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GET YOUR
RESOURCES

You're three steps away from this
issue’s video training and files. ..

1. GO TO THE WEBSITE
Type this into your browser's address bar:
www.creativeblog.com/vault/3dw205

2. FIND THE FILES YOU WANT
Search the list of free resources to find
the video and files you want.

3. DOWNLOAD WHAT YOU NEED
Click the Download buttons and your
files will save to your PC or Mac.

PLUS!

There are more files, art and
resources waiting online...

Video-+files Download the files and
video to texture a still life render

Files Download the training for this
issue’s Artist Q&A tutorials

Artwork Download the extra tutorial
images to accompany Showcase

Files Download the files to get more
from the VR office project

FREE
RESOURCES

Follow the link to download your free files
www.creativebloq.com/vault/3dw205

Model & render
this mech!

VIDEQ+MODEL QUIXEL 2

Download the video training and model

FILES MASTER 3DS MAX FOR MECH MODELLING

Download the high-res art to follow along to this issue’s cover tutorial

VIDEQ+FILES VEGETATION

Create realistic foliage for arch-viz

VIDEO+FILES SCULPTING

Video to help improve your ZBrush sculpts

FREE MODEL SCI-FI FIGURE

Download this free Creative Market model

VIDEQ+FILES CLOTH SIMS

Follow the video to create a dynamic dress
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360/VR Production
Tools for After Effects

e Generate 360/VR from your comp

e Import stitched 360 footage,
or Equirectangular 3D animation,
and add graphics, text and VFX.

“SkyBox Studio is a necessity for
cinematic 360/VR production in
After Effects. Especially if you're
working with 360 degree footage.”

Mikey Borup After Effects With Mikey

(W |METTLE
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SEA CREATURE

ARTIST Beat Reichenbach
SOFTWARE ZBrush, Mudbox,
Mari, Maya, Headus,
Photoshop, V-Ray, Nuke

Currently in the final year of his Digital
Production for Entertainment programme at
Los Angeles’ Gnomon School of Visual Effects,
wiss artist Beat Reichenbach created his Sea
reature over 10 weeks. Making sure there was
>asis for the image — which in this case came
of Carlos Huante's original creature

3D WORLD VIEW

“Beat's certainly
achieved the great
texture he was after
with his barnacles.
| like his use of the
spPaint3d script. “

|AN DEAN
Editor




ARTIST Alessandro Barbos
SOFTWARE ZBrush, V-Ray, ~
“Mudbox, Cavit, :
Photoshop, After Effects .3

zil-based freelance artist, Alessandro
rbosa, made his Dwarf Warrior as a personal
ject. Taking three weeks to create, Ale
werked hard to juggle this around commercial
projects. Starting with a human base from
ZBrush, he painted the textures from scratch by
mixing'various native Mudbox brushes. “With
3D work ['think | know a little of everything, but
I'm not an expert in anything yet,” he says. ¥
While making his Dwarf Warrior, Alessandro 8
expanded his rendering and modelling skills to LT
create the figure’s hair and beard. “I'm pretty
happy with the result and | ended up finding
a way to create larger variations in colour an
| 'appearance,” he explains. Ale goes on to ad
that “for some parts of the fabric | worked with-
Marvelous Designer, while some parts, like the J
leather jacket, were modelled in 3ds Max.” A
In the past year Alessandro has focused on
characters, due in part to the power of modern
3D software. "It allows us to create images of
| \great realism, but this also challenges artists.”
See more of Alessandro’s portfolio-at :
WWw, artstatlon com/artzst/alebarbosg, -

'y
/7l 3D WORLD VIEW

“"Alessandro has

/, definitely mastered the
/' art of hair creation. The
hair and beard really
give this warrior his
character.”

DARREN PHILLIPS
Art editor

3D WORLD March 2016
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DAVINCI RESOLVE 12

The world’s best color corrector is now the world’s best editor!

Only DaVincl Resolve 12 combines professional editing with advanced
color correction so you can edit and grade from start to finish, all In one
single software tool! With over 80 Incredible new features Including
multicam edlting, advanced trimming, high performance audlo, and
Incredible media management, DaVincl Resolve 12 Is the editing solution
you've been walting for.

Super Fast Editing

DaVincl Resolve 12 has a massive set of professional editing and
trimming tools that work exactly as you expect. You get context sensitive
editing, dynamic and asymmetric trimming, titling, transitions, animation
and more! The famillar multl track timeline, customizable Interface and
keyboard shortcuts make It easy to switch to DaVincl Resolve 12.

Incredible Multicam

No matter how many cameras you have on your shoot, DaVincl Resolve
12 lets you edit programs shot on multiple cameras faster than ever
before. Quickly sync angles using timecode, In/out points, or even
automatically based on sound and then watch them all playback In
realtime while you cut between angles on the fly!

www.blackmagicdesign.com/uk

Unlimited Audio Effects

Now you can create the perfect mix by adding VST and Audlo Unit
plugins to entire tracks or Individual clips! Resolve's sample accurate
playback and smooth tape style scrubbing let you precisely edit audio
In the timeline, or you can record fader automation using the new mixer!
You can even export directly to ProTools for finishing!

Hollywood'’s Best Color

DaVincl Is the world's most trusted name In color and has been used to
grade more Hollywood films, TV shows, and commerclals than anything
else. Now you can switch between professional editing and Resolve's
legendary color tools with a single click. DaVincl Resolve 12 goes far
beyond anything you'll find In any other editing systems!

DAVINCI RESOLVE 12

Free Download now, for Mac OS X and Windows.

View Demo



"BABY CHEWBACCA

ARTIST Thales Simonato
" SOFTWARE Maya, ZBrush,
o Yeti, Mari, Arnold,

alShaders, Nuke

As a freelance 3D artist, Toronto based
Thales Simonato has spent four years working
on commercials for companies including
Kumite and Tribbo Post. Created
between freelance commissions, Baby
Chewbacca took Thales roughly three
months to complete.

Based on an original concept
by Salvador Ramirez, this stylised
Wookie required Thales to
experiment with new skills.
enjoyed the challenging part the
most, which was creating the fur,”
he explains. "l love the original
concept and for a long time |
wanted to create this image, so |
waited until | got some experience
in fur development.” To make things
more complicated, the fur obscured
the base shape and made it difficult
to model. “So, | made a base body,
and while | was doing the fur | would go
back to the modelling, re-model and
use it as a morph target,” Thales says.
“| also used the rigging to help me to
reach the shape.”

Besides being inspired by other
3D artists, such as Pedro Conti and Ali
Bitaraf, Thales finds creative potential
in his everyday life. “I really love what
| do,” says Thales, not at all fazed by
the difficulty of this project. “I'm
always finding ways to improve myself
as an artist.”

To see more of Thales’ work, visit
www.thalessimonato.com

ul

€

3D WORLD VIEW

"“We're all huge Star

* Wars fans at 3D World,
so Baby Chewbacca
proved very popular.

~ The fur that Thales has

' created is superb — he's
mastered that skill.”

IAN DEAN
Editor

3D WORLD March 2016 www.facebook.com/3dworldmagazine




KeyShot

Amazing renderings and animations. In realtime.

) v rar 2 y. [ : - -.
- The flexibility to work with your ZBrush/Maya/3DS/ files. Lusciou
materials that are ready at the starting gate. More time to create

beautiful images. Less time wasted. You can create high-quality
visuals faster than ever before, and you can do it using KeyShot.

Model by Luigi Memola '(.)’ Learn more at
behance.net/memolaluigi ‘ keyshot.com



SHOWCAS‘ ._
- FLY FISHING

l { : Simon Edwards

RealFlow, ZBrush,
Sketching the idea , o
Freelance architectural visualiser Simon Edwards

3ds Max, Photoshop, V-Ray
and Settmg a mugh B = : : is inspired by films, especially dramatic scenes
i = where he studies the composition of camera
HH A =) angles and lighting. This influence can clearl
ComDOSItlon was L 5 3 o R ; A begseen in thge dyngamic Fly Fishing, which togk
. 3 AT PR IR : y & Simon four weeks to complete.
therapeunC w ' G ; T ' To create a sense of movement, Simon had to
i = ' get to grips with a range of textures. “The water
dynamics were created by building two low-poly
representations of the fish and surrounding
weed, then animating their movement through a
water object in RealFlow over a one-second time
frame,” he explains. “The ‘whipped up’ sand is
an instanced spherical object following multiple
helix paths as a particle array.”
Simon relied on pre-planning and concept
art. "Sketching the idea and setting a rough
composition was therapeutic. This is always a
good idea, especially when modelling detailed
forms in ZBrush. You want to avoid repositioning
things too much later on, or discover additional
areas requiring extra modelling.”
You can see some more examples of Simon’s
| work at www.3dartvision.co.uk
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3D WORLD VIEW =
“Fly Fishing is one of &

my favourites this issue.

| imagine animating the

movement was a lot of

fun to do.”

FELICITY BARR
Production editor

3D WORLD March 2016 L N www.facebook.com/3dworldmagazine
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“Soojong has created
a stunning render and
it's good to see he's
experimented with
different software.”

DARREN PHILLIPS
Art editor

GIRL

ARTIST Soojong Kim "
SOFTWARE ZBrush, 3ds 4
Max, Marvelous Designer,
Photoshop, V-Ray

Having started his VFX career working as a
general 3D modeller, South Korean artist
Soojong Kim moved into the video games
industry six months ago and now creates 3D
characters. Girl is based on the 2D illustrations
of Irakli Nadar and took five weeks to create.

“I spent a week and a half on the modelling
and texturing, two weeks styling the hair using
Hair and Fur, and two weeks on lighting and
tweaking the final image,” he explains.

Despite Soojong’s 3D experience, the Girl
project still taught him new tricks and posed
problems to solve — but these obstacles and new
approaches are part of the fun. “Typically, | work
with game engines or Marmoset Toolbag, but
here | wanted to create an image with V-Ray.”

After creating the headsculpt in Mudbox,
Soojong blew up the base mesh to a life-size
scale and started a rough sculpt of the hair
to measure volume and proportions. “To be
honest | didn't plan it well before | started work
so it took longer than usual. There was a lot of
back and forth, minor changes and tweaking.”
Soojong recommends running images past
fellow artists. “They could point out what | had
been missing at a glance.”

Find more of Soojong’s character work by
visiting www.artstation.com/artist/salmon
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COMMUNITY

News and views from around the
international CG community

18 JOIN THE REMOTE WORKING REVOLUTION 20 SPACE EXPLORER

How new ways of working are handing the power back to artists and small studios The best of Creative Market revealed

22 LIFE IN THE FAST LANE 24 WITCH MAGIC

How Humster3D's Car Render Challenge winner created his immaculate render The VFX behind The Last Witch Hunter

14
4

GET PUBLISHED

EMAIL YOUR CG ART TO

ian.dean@futurenet.com

Visit the online Vault to download
extra process art for these projects:

www.creativeblog.com/vault/3dw205 26 MAKING THE REVENANT

The challenges of creating seamless reality ~ How YellowDog is using crowdsourced processing power to transform rendering
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| THEBIG ISSUE
JOIN THE REMOTE WORKING REVOLUTION

Tom May investigates how new ways of working are handing the
power in the VFX industry back to artists and small studios

industry, one thing's seemed

inescapable: the need for a
massive, unyielding infrastructure, with
all the costs and inflexibility that this
can entail. Recently, though, smaller
studios have been finding ways to buck
the trend and operate outside of the
normal setups. Take VFX Legion, a
division of Legion Studios, LLC. It's a
post-production facility in which, strictly
speaking, there is no actual facility.

While Legion has a headquarters

in Burbank, California, its 50 artists
are distributed across the globe,
contributing to each new project
from wherever they see fit. Why?
“There's a really strong desire
to want to work on VFX but
not have to live in the most
expensive cities in the
world,” says founder and creative
director James Hattin. “We have fibre

For most of the history of the VFX

3D WORLD March 2016 é 3dworld.creativeblog.com

connections to our technology partners
and serve out hundreds of gigs of data
a day to artists all over the world. We
climbed this hill simply because we
could, and it seemed like the right
thing to do.”

“In general, this model works far
and above expectations,” he adds.
“We can deliver hundreds of shots per
week, which is something most people
doing remote work find impressive.
The challenge is thoroughness of
information to the artists. We use
Google Hangouts, Aspera and a robust
Shotgun-based pipeline; we also make
use of the remote review and approval
tool cineSync. But there is still more
information that doesn’t always filter
through. Once we solve that bottleneck
| think we will be well on our way to
having a hugely expandable model.”

Overall, though, the pros far
outweigh the cons. “This way, artists

can have a life,” he enthuses. “We
have artists that are farmers in New
Zealand, artists that live in the middle
of America, in places one would never
expect of someone who works on A-list
movies and TV shows.”

UK-based studio Rawpost follows
a similar model, and tells a similarly
upbeat story. "All of our
staff and freelancers work
remotely at the moment,”
explains company director
Jeremy Emmerson. “In practice it really
comes down to the client and their
budget vs workflow requirements; we
then creatively ‘'manage’ the team no
matter where they may lurk. Many
clients find it hard not being in a
traditional edit suite initially,” he adds,
"but soon get the hang of it when they
see the benefits.”

“It's about confidence,” he continues.
"Confidence that your client has that
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you are just as ‘present’ in remote as
you would be in studio. Master that and
you can edit on the moon whilst your
client s fishing in Alaska.”

Or if not the moon then how about
the beautiful Hawaiian island of Maui?
That's where Capital T carries out VFX
work on big budget movies such as
Ant-Man, Avengers: Age of Ultron and
Insurgent, as co-founders
Lindsay and Jamie Hallett
explain. "After nearly two
decades in the business,”

says Lindsay, “we knew we still loved
what we did. But we were hoping to
take it down a few notches so we could
balance work with time with family, and
we both love the islands. We spoke to
all our clients prior to departing the
mainland to see what they thought. We
are fortunate enough to have earned
people’s faith in us, so we brought
them here with us, in spirit and VFX."

Capital T creates VFX for
blockbuster movies from
the calm of Maui

@by SR h,

"We haven't had any issues
to date (knock wood!),” adds
Jamie. "The time zone here
works in our favour. We start
our day when the sun comes up and
wrap it up in the late afternoon (closing
time on the mainland). Still enough
time to hit the paddleboard!”

But what's it like as the remote
worker? Craig Crane, Lidar supervisor
for Marvel, gives us a view from the
=3 other end of the wire: “I

T tended to work remotely
i‘g“i whilst Lidar scanning when
A at Double Negative, starting
with John Carter,” he explains. “The
reasons ranged from either being
overseas on location or working
through the night on set, scanning on
wrap. |'d work from anywhere | could
set up a laptop — hotel rooms, craft
services, airport lounges. And of
course, on set.”

Craig sounds a word of warning
about remote working, however,
suggesting it's not always perfect.
“Time management is a skill you need
to learn. It's all too easy to do a 20-hour
day when you don't have a commute
either end of it. Knowing when to
switch off is a real skill, and one that
| learnt through many years of not
switching off.”

Find out how the Cloud is changing the
industry at www.bit.ly/vfx-cloud

3D WORLD March 2016 é 3dworld.creativeblog.com

INDUSTRY INSIDERS

Thoughts & opinions from the experts

CRAIG CRANE
Director, Motion
Associates Ltd
www.linkedin.com/in/
craigcrane

"The biggest issue
with remote working
is the security of the
data, so backups

and encrypted

drives are essential.
My company Motion
Associates is a
provider of on-set
Lidar scanning for
VFX and takes clients’
security requirements
very seriously, to the
point that we
invested £40K last
year alone in security
measures to ensure
we are compliant.
These measures are
applicable to
working on-set, in
our studio in Sussex
and beyond.”

JAMES HATTIN
Founder, VFX Legion
vixlegion.com

“[ first came up with
the idea of a fully
remote pipeline in
2000. ISDN was the
fastest internet we
could afford. Living
400 miles from

my office in Santa
Monica, I'd make a
duplicate drive of all
the data needed to
composite the work,
then transfer project
files back and forth
between home and
work. Rendering
would happen in
both places. I'd
remote access the
office computer with
the director sat at
the machine and
play back the movies
to get approvals or
notes. It was a poor
man'’s process since
replaced by tools like
Google Hangouts and
Cospective CineSync.”

JEREMY EMMERSON
Director, Rawpost
rawpost.co.uk

“We use industry
standard timeline
sync software that
allows multiple
computers to hook up
concurrently. When
my client in New York
slides the timeline to
the frame showing
the car as it crashes
through a window,
my picture in London
jumps to the exact
same frame. When

| draw a squiggle

on that frame, she
sees it at exactly the
same time. Playback
runs perfectly in sync
across all computers
that have logged on.
Very neat. We even
use it within the
same building as it
allows for frame-
accurate reviews of
a piece of work with
our own operators.”




COMMUNITY
Creative Market

CREATIVE MARKET

REACH FOR THE STARS

We're partnering with Creative Market to offer a series of free
downloads, continuing with Polygonmaker’s Space Explorer Lite

hen you're creating amazing
new 3D worlds, you need
someone to explore them.

Who better than this awesome space
explorer, an animated character with
optimised polygon count? It's the work
of 'Polygonmaker’, aka Brazilian 3D
artist Fabio Brasiliense, who specialises
in creating 3D art for mobile games. His
work can be seen on Creative Market.

A platform for digital design content
from independent creatives around
the world, Creative Market recently
launched a 3D art section. It's a great
place to sell your content, says Fabio.
“I've been creating characters for

FABIO BRASILIENSE
Fabio, aka Polygonmaker,
is a supplier of royalty
free art packages for
game developers.
www.creativemarket.
com/polygonmaker

MARKET

FREE!

CHARACTER

MODEL

Fabio specialises in
the creation of 3D

art for mobile games,

like this amazing
space explorer

online stores since 2011, and
& uploaded the models to
- Creative Market just before
[ the 3D store opened,”
he explains. "It looked like a great
opportunity to expand the business.”
Fabio has two main workflows when
creating his models. The first is a low
poly workflow. “Sometimes | sculpt a
very basic model in ZBrush to get the
overall proportions and then finalise in
3ds Max; others | just model directly in
3ds Max,” he explains.
“Then | create the UV's rig and
animations in 3ds Max. For texturing
| use mainly Photoshop. | also use an

Working with new tech is a great experience.

I've always liked challenges, and sometimes
we make things that haven't been done before

old version of BodyPaint only to fix the
seams and paint some trick details.”
Fabio’s second option is a PBR
workflow, using ZBrush for the high
poly (3ds Max for some non-organic
shapes) and to create the basic low
poly. “I'll finish the low poly and create
UVs in 3ds Max,” he explains. “"And
I'll bake the maps from the high poly
using xNormal. | use handplane to get
the Basic Normal map; Photoshop to
clean the maps; and Quixel to create
the base materials for PBR. I'll finish
the textures in Photoshop and use
BodyPaint to fix the seams.”

Enjoying the challenge
Fabio has been working in the industry
since 2008, when he took an animation
course at QANTM School in Brisbane,
Australia. He's spent the last 18 months
working as a character artist for Oculus
VR. "Working with this new tech is a
great experience,” he enthuses. “I've
always liked challenges, and sometimes
we're making things that haven’t been
done before.”
Once again we've partnered
with CreativeMarket.com to make
Polygonmaker's Space Explorer Lite
available for readers to download -
absolutely free for personal use! To get
the free model visit our online Vault at
www.creativebloq.com/vault/3dw205
and download. This pack is free for
personal use only: to purchase for
commercial use, visit bit.ly/205-shop.
For more of Fabio’s work go to
creativemarket.com/polygonmaker
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HORDES
OF HEROES

There’s more where
that came from...

HEROES - DARK
KNIGHT

This high quality
animated knight
comes with two
LOD levels (3344
tris and 1554 tris)
and two high quality
sets of textures. The
package includes 12
animations. Get it at:
bit.ly/205-knight

FANTASY HORDE —
TROLLS

These animated
characters come
with an optimised
polygon count, two
LOD levels (6000tris
and 3000tris) and four
different textures.
The pack includes 12
animations and face
rig. Download here:
bit.ly/205-trolls

LOW POLY GOBLINS
These three low

poly goblins are
optimised for mobile.
The pack comes with
950-1050 tris for the
complete character
and weapons, three
textures on each and
eight animations.
Download it at:
bit.ly/205-goblins
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COMMUNITY
Industry project

This stunning scene
won Carlos Pecino
first place in the
Humster3D Car
Render Challenge

INDUSTRY PROJECT

LIFE IN THE FAST LANE

Carlos Pecino explains how he created this contest
winning scene of Mercedes’ flagship sports car

he winning entry in the Car
I Render Challenge set by
Humster3D, this Mercedes AMG
GT 2080 takes our breath away. The
composition is full of energy and
character, with a stunning degree

of photorealism. A huge amount of

modelling work has clearly gone into it.

CARLOS PECINO
Carlos Pecino, aka
ColorSponge, is a 3D
artist with more than

12 years’ experience in
the digital world. Clients
include Vodafone, Repsol,
Bankia, BMW, Audi,
Acciona, Ono, Orange
and Burger King.
www.colorsponge.net

“The inspiration comes from
many sources,” explains
Carlos Pecino, who created
it using 3ds Max, V-Ray and
Photoshop. “They include the www.
speedhunters.com website —a must
for every motoring enthusiast; the
artist Khyzyl Saleem (his 2D portfolio is
amazing); and of course | always try to
work with photographic references.”
Finding references was, however,
initially tricky and Carlos had to scour
motoring forums to find suitable
references for the different parts of
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the car. He then set about the task of
modelling, starting with basic shapes,
creating the chassis structure and seat,
then developing other parts of the
vehicle including the wheels, bumper,
spoilers and cooling system.

“| decided that | would dive deep
into the 3D modelling of the details,”
he explains. "At this stage, | didn't have
a precise vision of what the final scene
would look like, so | just wanted it all to
be in the model for later. At that time
| was thinking about one or two main
views and also about close-up views.
Having a detailed 3D model gives an
opportunity to make flexible decisions
about those things later on.”

Carlos put a lot of time and effort
into developing appropriate lighting
for his scene. "I didn't want just to
set a VRayLight and have it done,” he
explains. “The lights tell us a story,
providing the hue and enhancing the
shaders, so | really needed to get the
atmosphere right.” Colour was another
headache, he adds. “Once | had the
post-production done, | spent days
changing tones, saturation and levels,
transferring the final image through
different screens.”

However, the biggest technical
challenge Carlos faced was optimising
both the modelling and texturing. “It
was a matter of being focused on every
single process and not wasting my
24GB RAM," he explains. “Too many
unnecessary polygons and oversize
textures would have killed my PC!”

Ending the year in style

It was all worth it in the end though,
with victory in the competition capping
off a great year for the artist, who's
been working in 3D for 12 years across
architecture, graphic design, illustration
and advertising.

It all began when he was 15 years
old, he explains. "A good friend
brought me 3D Studio MAX R3, and
| started as an autodidact, using it
to recreate very simple scenes like
interiors, buildings, and especially
cars. | realised that there was a world
to satisfy my artistic and professional
inquietude. | believe these 3D
programs bring us the necessary tools
to recreate anything we imagine. The
only limits are in our minds.”

For more details on the Humster3D
car challenge, visit bit.ly/humster-win



The second and third-place winners

Carlos’ attention to share their insights

detail even extends to
modelling the welds

SICK BASTARDS
on the roll cage

Second place in the Humster3D
competition was ‘Sick Bastards' by the
RStyle team, who used 3ds Max, Corona,
ZBrush and Photoshop. “Producing this
image gave us a good workout with UVYW
texture unwrapping,” explains founder
Konstantin Rozumny. “The hardest part

to model was the car's engine — | had to
dive into mechanical drawings and photos
to make it."” Working from one camera
view enabled him to add a huge amount
of details to the foreground objects. “This
gives an impression that all the geometry
in the image is very detailed. | also spent a
lot of time on textures, most of which are
custom handmade. Bump maps, reflection
maps and dirt maps add a great amount of
detail to the image, even if the geometry is
not very complex.”

-

rm!!/“u

THE LAST BATCH

Third place went to The Last Batch by Piotr
Tatar, which was inspired by Breaking Bad.
"There aren't so many pictures of this
vehicle on the web, so | used stills from
the show as reference if | didn't know
how to model or texture some particular
part,” explains Piotr, who used 3ds Max,
V-Ray, Nuke, FumeFX, Marvelous Designer,
Photoshop, Mari and SpeedTree. He
established his camera at an early stage
with a simple box and cylinders to represent
the car. “I tried not to make big changes
until the end,” he says, “which helped me
to focus only on the visible elements and
add as much interesting detail as | could.

| rendered this picture at 5K resolution

and every test was also made at this final
resolution with region rendering.”

Carlos’ modelling
is excellent yet still
quite poly efficient
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IMAGINE THE MAGIC OF VEX

Image Engine reveals the magic behind The Last Witch Hunter

Image Engine used a
mix of techniques in
Nuke and Houdini to
create 150 shots for
The Last Witch Hunter

SHANE

& MAT'S
PROTIPS

Improve your
process...

1.TRY IT YOURSELF
“Learn to look at
things critically.
Investigate how a
shot or scene was
put together, look
at the development
of the shot and

try to emulate it,

if possible.”

2. KNOW THE TOOLS
“In comp you need

to know your toolset.
You should be ready
to go, and artists who
can be ready to jump

on shots without
thinking what tools
do what are essential.
Train yourself to look
at colours and so forth
in a shot and know
which tool was used.”
3. WHEN TO PASS
“Take time to

look at how shots
are created and
understand what
can and can't be

root structures, various props and actors with elaborate
hairstyles, the rotoscoping was particularly challenging.”

Each sequence as well as many individual shots
represented unique challenges, meaning that assets
were rarely reused. “There were lots of shots with one-
off design bits; this project had more of a generalist
feel,” says Mat. "We had to design new looks over and
over again, rather than rely on one asset added into
multiple shots.”

Make the magic

The subject itself offered a unique challenge. Magic is
very subjective when presented in films: “There’s always
a learning curve to establish what they want, as it means

Coming on to a movie late in
production can throw up its own
challenges, as Image Engine
discovered when they were drafted
in to add a little magic to Vin Diesel’s
fantasy movie The Last Witch Hunter.
Many of the sequences awarded

to Image Engine were not initially
intended to have CG touches.
“Coming in late on the
project we were asked to
make things look a little bit
more mystical and exciting,

MAT KRENTZ

Mat has worked in
film for over 15 years,
with credits including

Transformers 3, Game of
Thrones Season 5 and
The Da Vinci Code (for

which he received a VES

nomination). Mat is also
a Leo Award Winner.
www.bit.ly/mat-krentz

SHANE DAVIDSON
With over 16 years in
the industry, Shane has
worked on some exciting
films, including Chappie.
bit.ly/shane_davidson

such as adding burning runes and
magical auras floating about and

above candles,” explains visual effects
supervisor Mat Krentz. “While we only
worked on around 150 VFX shots on the
show, they all contained very different
types of work, from CG set extensions
to 2D compositing work.”

A particular sequence was the ‘Witch
Council Chamber’, which was shot on
set but the director, Breck Eisner, felt it
looked too enclosed. Image Engine's
concept artist Rob Jensen worked with
the client’s designs to provide a look
that transformed the set from a simple
brick rotunda into a wider cathedral
with recessed statues. “We built a full
CG set to make it larger and grander.
This was challenging as it was after the
fact and no green screen was used on
the set,” says Mat.

“As a practical set, it
was not set up from a
compositing standpoint
—the set extension was
an afterthought,” adds Shane
Davidson, Image Engine compositing
supervisor. “As it contained complex

different things to different people,” shares Shane.

CG magic needs to be photoreal but feel unreal, so the

FX team ensured the CG magical effects were grounded
and driven by the lighting in the plates. “For example, in
the bar scene, they wanted to make a witch bar feel full of
magic,” says Shane. “To that end the effects were based
on candles that existed in the practical plates.”

To see more of Image Engine’s VFX go to

www.bit.ly/witch-hunter

R

Image Engine Workedd

with Rodeo FX to help
the bar scene feel
"full of magic”

2
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done, and when to
hand off to another
department. Using
the bar scene as an
example, we used
Houdini for the FX
elements as we
couldn't easily do
them in Nuke, which
was better tackled
using dedicated
effects software.”

4. STUDY & LEARN
“Learn to watch

a movie and
understand how it
has been built, who
did what and how the
different departments
work together to take
advantages of their
strengths, and then
be able to articulate
that back — this is

an important skill

to master.”



LOSE YOURSELF IN A WORLD OF
Vinyl

FIND YOURSELF IN
OXFAM’S ONLINE SHOP

oxfam.org.uk/shop
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| VEKINTERVIEW

CREATING A SEAMLESS REALITY

MPC’s Arundi Asregadoo tells Trevor Hogg the challenges

of creating natural realism in CG for The Revenant

fur trapper Hugh Glass had

to withstand a harsh wintery
environment after being mauled
by a grizzly bear, the production of
The Revenant, which recounts his
epic tale of survival and revenge,
encountered unforgiving and fickle
weather conditions that played havoc
with the desire of the filmmaker
Alejandro G. Ifarritu to shoot outdoors
using only natural light. As much as
cinematographer Emmanuel ‘Chivo’
Lubekzi was able to capture the
imagery in-camera, some digital
assistance was required with MPC being
one of the key visual effects vendors.

J ust as abandoned 19th century

ARUNDI
ASREGADOO

Arundi has over 15
years' experience in VFX
work at MPC, with
films including Exodus,
Skyfall and Dark
Shadows on his CV.
www.bit.ly/205-Arundi
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“Richard was looking for
realism and a natural look

to the CG animation and
effects we were tasked with
creating,” states MPC VFX supervisor
Arundi Asregadoo when discussing his
conversations with Richard McBride, who
oversaw the visual effects work. “He and
his team gave us references to help us
create the look. In a meeting, Alejandro
said, 'l would like you to create the
effects with one hand behind your back.
I don't want it to look like fantasy.””

A continuous shot occurs when the
hunting party is besieged by hostile
Arikara Indians which results in them
fleeing to their boats. "MPC was

awarded the open sequence to the
film, which comprised of 40 shots. Each
shot was created by stitching together a
number of scans/plates. Once the new
plate was created CG and 2D elements
were composited into it to create the
final image. This process was recreated
for each shot.”

Natural realism

Influencing the creative process was the
snowy conditions illuminated by natural
light. “The photography was stunning,”
notes Arundi. “In order to create the
feeling of one continuous shot, all
images had to be shot at the same
time. Chivo achieved this by filming



Subtle CG, including
a horse, was used to
retain the natural
feel of the film

everything within the ‘magic hour’ so
that the angle of the light and colour
temperature of the image was as close
as possible to each other. This gave us
a great base to work from. To create the
seamless blend from one shot to the
next we had to replace the sky and add
2D elements to help create the illusion.”
An array of computer software
was needed in order to complete
the assignment. “We use Autodesk
Maya as a basis for many of our
disciplines along with our own in-house
proprietary software plug-ins; Nuke for
compositing and Katana for lighting.”

The challenge

“One of the difficulties was dealing
with the parallax within the image,”
reveals Arundi. "The scene takes place
along a river but we also travel amongst
trees, which made it very difficult when
you try to stitch one plate to the next.
Another challenge we had was in
blending the scans. In some cases they
were shot in different formats, in others
one plate would be shot using a track
and the plate that we had to blend into
would be shot on a Steadicam. The

solutions were a combination of digital
matte painting projected to parts of the
shot that needed to be retimed. A lot of
it was down to compositing tricks.”

The efforts of Richard McBride, MPC,
ILM, Cinesite and Gradient FX have not
been overlooked as The Revenant is
one of the favourites to win the Oscar
for Best Visual Effects. “The viewer will
not notice how much work went into the

Alejandro said, ‘T would like you to create

the effects with one hand behind your

back. | don't want it to look like fantasy’

sequence,” says Arundi who produced
over 100 scans to invisibly blend the 40
shots into a continuous one. "A horse
is shot in one of the most disturbing
moments of the movie. Hopefully,
they'll wonder if the poor horse was
an amazing actor but obviously we
created a full CG photo-real horse for
the scene!”
To see more on MPC’s work on The
Revenant, visit bit.ly/205-revenant

3DWORLD March 2016 é 3dworld.creativeblog.com

AWARDS
SEASON

The VFX triumpths of 2015 that are
battling it out for glory

OSCAR SHORTLIST RELEASED

At the time of going to print the shortlist for
the best VFX Oscar for 2016 was announced
and included 10 films that stood out in

2015, of that list MPC had worked on many,
including The Revenant. As you read, this the
list will have been baked off to the final five
movies, but we're predicting a tussle between
The Martian and Star Wars: The Force Awakens.

The 10 shortlisted movies are, Ant-Man,
Avengers: Age of Ultron, Ex Machina, Jurassic
World, Mad Max: Fury Road, The Martian,

The Revenant, Star Wars: The Force Awakens,
Tomorrowland and The Walk.

Adam Valdez, MPC animation director
and VFX supervisor says, “2015 has been a
significant year across all the MPC sites. Artists
have continued to bring their collaborative
spirit, creativity, determination and technical
prowess to a wide range of work, and our
studio continues to grow in all ways.”

“Currently in production are some of our
most challenging projects to date, not least
of which is Disney’s The Jungle Book, which
has occupied the last two years of my time,”
says Adam, who points to 2016 as a year that
could eclipse 2015 for VFX work. “Every group
within the studio has brought their best for
some amazing results. Other movies in the
works for 2016 include Batman v Superman,
Independence Day: Resurgence, Ghostbusters,
X-Men: Apocalypse, Suicide Squad and
Fantastic Beasts. The people of MPC continue
to amaze me, and the work becomes more
intricate and real and beautiful as the state
of this art evolves. 2016 should be even
bigger for us.”

A mention and best wishes must go to all
the vendors involved, including Industrial Light
& Magic, Double Negative, Rodeo FX,

Milk VFX and lloura.

The 88th Academy Awards winners will be
announced live on February 28th, 2016, so
don't forget to visit www.creativeblog.com for
the news of who's scooped the award.
WWW.0SCar.go.com

The Martian'is
one of 10 movies
on the shortlist



INDUSTRY INTERVIEW

YellowDog offers a
\ distributed, crowd-based
~model for 3D rendering

THE NEW RENDER REVOLUTION

By using crowdsourced processing power, YellowDog aims to change rendering
as we know it and eliminate the need for investment in costly render farms

hen it comes to the next big
technical leaps forward for
3D studios, rendering is one

of the hot areas for development. The
UK's Bristol-based YellowDog is one
company that's taking an innovative
approach, which could prove to be a
game-changer for small studios.

YellowDog allows you to scale your operation
as needed. | respect that they've sought out

artists and listened to us from the beginning

In simple terms, YellowDog releases
the spare processing power from
people's computers, and pays them for
the privilege. This processing power

is then offered to studios, giving them
their own ‘personal supercomputer’

Virtual Planit used
YellowDog to render
complex architectural
visualisations

GARETH WILLIAMS
Gareth is managing
director of YellowDog
and has a background
working in software
and telecoms.
www.yellowdog.co

RICH LINE
Richard is partner

at Virtual Planit, a
team of visualisers,
graphic designers,
gamers and even a
landscape architect.
www.virtual-planit.com

to improve how they render their creations. While
- outsourcing rendering to external companies is
& nothing new, managing director Gareth Williams

argues that with conventional render farms, the

JUSTIN DOWLING
Justin is a CGl artist at
JD3D Ltd, a Bristol-
based CGI business.
His work has ranged
from architectural
visualisations to
finished animations.
www.jd3d.co.uk

time the job takes and its costs are often unpredictable, and
the process often overcomplicated.

“It's not unusual for there to be errors in the final rendered
animation from render farms,” he adds. In contrast,
YellowDog promises predictability of cost and time taken.
“Studios only get charged what is quoted and the time taken
to process is precisely calculated up front,” says Gareth.
“Also, compared to many technically complex render farms,
YellowDog is very easy to use and interact with.”

It's still early days for the company, but the pilot customers
seem happy with the way things are going so far. Take

Rich Line, partner at architectural visualisation
studio Virtual Planit. “We were producing a CG
ﬁ, animation for Liverpool Football Club and needed
' some extra fire power,” he explains. “We heard
YellowDog were looking for beta testers, so we've spent the
last six months working with them to develop their service.”

"When we first started, we could only render with Brute
Force,” he continues. "But now they've begun to incorporate
light cache and irradiance maps as well as accommodating
the plug-ins we use, such as MultiScatter and Forest Pack.
The service has stacks of potential and in time will be a
market leader in crowd based rendering,” he believes.

Another beta tester, Justin Dowling of JD3D, is similarly

enthused. "There have been many areas that

YellowDog has improved since | first saw it, and

it's well on the way to being the one of the best

render services |'ve used,” he says. “YellowDog
allows you to scale your operation as needed — definitely
small studios and freelancers will benefit.”

"It was very easy to use and set up, and | respect that
they have been seeking out artists and listening to us
from the very beginning.”

For more information on YellowDog and how it
operates, visit www.yellowdog.co
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Wl N A Fact-Finding Forest Trip
to a European Paper Mill

Did you know that almost 70% of
paper across Europe is collected
and recycled? In fact, it’s one of the
most recycled materials of all! *

Magazines are printed on paper
from natural and renewable wood,
which is great to know if you love
reading your favourite magazine.

T Monitoring Report of the European Recovered
Paper Council (ERPC), 2010

To discover some surprising
environmental facts about print

and paper, visit

Print and Paper.

Win one of 30 European trips for two people to see i labiog ¥ ‘
?ee 019 wwd‘r‘ ; © sustainable forestry and paper making in action! The envi f::;r!”“mg;[

/ P £
and the tpeeJ' " BUPP TO ENTER or visit twosides.info/compefition surpriseyou LU

Entrants must be aged 18 or over. Entries dose 31.01.16. For full terms ond conditions visit www.twosides.info/competifion-terms



EXPERT PANEL

Q&A

Your software queries solved
by our CG experts

Playing with the design of
an existing character that
was cute or loveable, then
enhancing the threat, can
create impressive results

GET IN TOUCH

EMAIL YOUR QUESTIONS TO

ian.dean@futurenet.com




How can I make my robots more menacing?

Charles Lewis, UK

Rob replies

| There are two main approaches
to answering questions like
these. The firstis all about the
4. design of the robots themselves.
If you want to make a dark, nasty, scary style
of robot then work on your silhouettes;
creating something either pointy and
vicious, or possibly more insectoid like. This
is a topic that covers a multitude of aspects
—from concept art to modelling —and I'll
cover that in a later article, but for now I'm
going to concentrate on the second option.
For me, what can make for the scariest,
most unsettling results, is playing with
the themes and designs of an existing,
probably cute, loveable or at least benign,
character and then using your layout to

b

STEP-BY-STEP
ADAPT WHERE NEEDED

Some robot characters will suit a more
menacing style of render better than others,
so have a think to see if there’s a way you
can make any small adaptations to help the
viewer see what you intend. This is especially
helpful with a known character, where you
are trying to force a mood. My little bot really
needed an obvious way to make him less
cute, hence the glowing red eye.

UNEXPECTED PERSPECTIVE

There are a few things you can do with your
cameras that will help unsettle an audience.
First off, make them feel physically off kilter
by tilting the camera on the Z axis. This
adds drama, as well as helping the viewer
feel uneasy. Next, you might want to get
really close to your subject and use a wide
angle lens to frame the scene. These two
combined work wonders for horror shots.

DISTORTION

This is a follow on from the previous step
and can be used as little or as much as you
like, but a little lens distortion can go a long
way. Some barrel distortion can really add
to the feeling and even introduce a little
nausea, which although slight, can have a
big impact. Most 3D apps these days have
settings for physical camera attributes, so
experiment with different looks.

HIDE THE DETAILS IN SHADOW

We tend to be more afraid of things we can't
see and understand, so a great trick that will
help your robot look more intimidating is
back light, leaving just a silhouette showing.
This masks any real emotional tell-tales — if
your character has the ability to show any —
and plays tricks on the mind. A little volume
in the scene can enhance this, so get your
robot blocking the light too.

enhance the threat, or hint at the menacing
nature of your render. There are many ways
of doing this and I'll talk about the few

that | chose for my project, which is based
on a cute little robot character that has
graced the pages of 3D World many times
—normally in its more fun manner.

First up, | made one single change to
the character’s design and that was to the
material of his eye. Normally his eye is a
simple blue-led representation of an eye,
but | decided to make it a red glowing ring.
Red is a more emotive colour, and to many,
expresses malicious intent. It also refers to
certain pop culture references, especially
in this context, like HAL from 2001.

The rest is down to the camera. Firstly,
add some threat to the scene, so move

the camera down low — at least below the
head level of your robot, so it looms over
the point of view. Even if your character
is small, this will help add that touch of
menace that's needed. | also like the jarring
feel of a camera that isn't sitting perfectly
straight on the horizontal. We are all used
to seeing film and TV where the camera is
seated on some kind of perfect support
and ifit's a handheld shot the operator
generally tries to keep things level - so
grab your camera and tilt it on the Z axis. |
also use a close camera with a wide lens to
push the feeling of things not being right.
Finally, | back light the robot so all that's
seen is the silhouette and the glowing evil
eye. Some volume light will help to finish
the shot off.

3D WORLD March 2016

EXPERT TIP

Noir homage

3dworld.creativeblog.com



ARTIST Q&A

How do I author hard surfaces

for a physically-based rendered

cockpit on a tight deadline?
Emily Pearce, USA

André replies

It's in the nature of game development
that some tasks will come in hot, where you
have to take a quick and dirty approach to
authoring. In our case, we were launching
a Kickstarter campaign for Infinity Battlescape
(www.inovaestudios.com/battlescape).

We decided fairly late in the ramp-up to launch
that adding a cockpit would better sell the immersion
of seamless transitions between empty space and
planetary atmospheres. Thanks goes to Eugene
Darlak for providing the 3D model of the SFC Hellion
which features the cockpit used in this tutorial, and to
Kristian Agrén and the rest of the Inovae art team for
the concept resources.

Prior to production, it is key to set yourself a time
frame and work within those constraints in order to hit
the best quality possible without overly focusing on
unnecessary detail.

An important initial step to my process is to gather
some rough reference material for surface textures.
The Hellion is part of the Starfold Confederacy Faction,
which emphasises an industrial aesthetic and function
over form. The main art direction for the texturing was
to make it look worn and used, but functional — having
a rough futuristic yet vaguely familiar design.

The Inovae Engine utilises the physically-based
metal roughness workflow with shaders that are
comparable to Unreal 4, so | chose Unreal 4 viewport
settings in 3DO to visualise my environment and
textures. | also used the Unreal 4 settings on export.
Whether using Unreal, Unity or any other engine, the
closer you can get to a visual representation of final
output materials within your engine of choice, the more
accurate, non-destructive and faster workflow you will
establish, as you'll cut down on iteration and switching
between toolsets.
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STEP-BY-STEP

EXPERT TIP

Preview in game

Anin-game cockpit view of
the Hellion as it approaches an
unexplored planet

MODULARITY

Build out various cockpit parts in a modular
format, giving flexibility moving forwards in
terms of organisation. This allows re-arranging
cockpit features and excluding non-essential
elements if time constraints become too
taxing. Each individual part is exported from
3ds Max. I'll focus on one of these modular
elements: a life support system that monitors
and assists pilot vitals. I'm using Quixel 2.0 as
my authoring package.

BASE AND LAYERING MATERIALS
Author textures at double resolution and
clamp them in engine. Unclamp them if
higher fidelity is required. Layer materials
in a way representative of their real-life
counter parts. For this piece, | started by
applying a dull aluminum material then
layered rust/painted metals over the top of
it. | painted out portions of the top material
layers in order to emphasise wear around
seams and edges.

EMISSIVE POLISH PASS

Use emissive details to infuse sci-fi influences
into textures. This works best when
complimented by placing strategic lights to
draw the eye to visually interesting sections.
Albedo maps should show the screens and
emissive areas in such a manner that the
systems appear powered down. This way, if
the emissive maps get occluded in the shader
for gameplay purposes, the visual default state
of screens are represented as ‘turned off'.

ROUGHNESS AND OPTIMISATION

Build textures within the context of
surrounding objects. If materials in proximity
of one another are similar, it creates an overly
uniform and muddy look. Vary and contrast
shiny and matte materials for visual interest
and hierarchy. Importing properly rendered AQ,
Normal and Cavity maps allows DDO to build
a solid foundation for wear build up. Pack

the exported textures into RGBA channels of
single textures to minimise memory overhead.

Aluminum
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EXPERT TIP

Add a gradient

How do I make my mechs look rusted and worn in KeyShot?

Liam Beattie, USA

Y’% Carsten replies

| In KeyShot 6 Pro, the Material

| Graph is one of the key

elements you can use to

! create a custom material with
multiple textures and bump maps. At
Unique Voodoo we brought our model
into KeyShot using the ZBrush to KeyShot
Bridge, then assigned a basic metal
material to the body.

To show that a mech is battle-

seasoned, like this Rusviet Unit, you
need to modify the basic materials. Start
by opening the Material Graph and
drag-and-drop textures. The Material
Graph also offers the opportunity to
add different textures and utilities with a
simple mouse click. My main texture of a
rusty metal is used as the colour since the

Carsten began by
assigning a basic
metal material to
the robot's body
in KeyShot

The Material Graph in KeyShot

‘provides a very efficient

workflow to create a realistic
looking texture for a
convincing concept render

mixture of brown rust and yellow metal
offers a good base. The first bump map is
based on the diffuse map. The Bump-
add palette is a very good tool that you
can use to mix different maps. So, | use
multiple textures as a bump and the noise
fractal that comes with KeyShot. You can
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now separately adjust each placement
and depth of the maps to achieve the
look you want. The graph offers a great
variety of settings and you can adjust
the material very easily without affecting
the original textures. To get the correct
colour, | mix the material with a slight
blue tone to get the green needed for
that rusty copper look.

The Material Graph in KeyShot
provides a very efficient workflow to
create a realistic-looking texture for a
convincing concept render. At Unique
Voodoo we use this workflow all the time
to show multiple options for material and
colour. If the concept render in KeyShot
is approved we can create the proper
texture for the model. Try it yourself and
experiment with your mech concepts.
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EXPERT TIP

Bigger isn’t always better

How do I begin making good hard surface textures?

Tim Preston, UK

o Cirstyn replies

If you're new to hard surface or
mech texturing, it's easy to get
a little lost in the options and
functionality Photoshop, or
newer texturing software like the Quixel
and Substance suites provide. However,
if you do a little texture prep work as you
go, it's much easier to get good results.

Keep it tidy, delete unused polys
as you go, name your items — or at
least groups — and use layers for easy
selecting, tweaking and in-program
map baking.

Also, be mindful of your high-poly
detailing; if it's too densely detailed,
your low-poly geometry may not be
able to hold your normal map’s detail,
causing errors — and in some cases, tears
in your baked map. As Photoshop can't
fix this, you may have to redo parts of
your model because of it.
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Normals also control smoothing. A
smoothing group’s function is to make
your model appear smoother without
adding polys to the mesh. Different
modellers have different tools for this, but
keep in mind that where one (or more)
polygon’'s smoothing stops, and another
starts, a hard edge is created. Separate

these in your UV map if you're baking
normals. Even though not every UV shell
needs a hard edge, hard edges do need
to be separate in your UV map for tangent
space normal maps. This is to give room
for error-reducing tangent twisting.

If you're creating a wartorn and worn
robot, that's full of bullet holes and
grunge, consider your model’s story
when selecting your palette. For
example, did you know that construction
equipment is yellow because it's the
sole colour in the spectrum that keeps
standing out in any environment,

even very dark ones? Or that there's
a trope for film and TV mechs? Blue,
cherry red, muted or earthy tones
for the good guys, and blood red,
navy, and unmuted, garish colours
for the villains.

3dworld.creativeblog.com



STEP-BY-STEP

ONE UVS MATTER

Good texturing bakes come from good UV
layouts. Map while your model is still low-poly,
and avoid normal artefacts by cutting seams

on hard edges when using Smoothing Groups.
Remember to create enough space between your
UV shells to facilitate edge padding and gutters.

gt o Ly

TWO UV SCALE MATTERS

Avoid the novice mistake of disproportionate
UVs and thereby textures by applying a
checkered UV map with colours, numbers and
letters. The default black and white ones usually
only show a semblance of stretch or slack, but
tend to ‘hide’ flipped or offscale UVs better.

THREE MIND YOUR MESH

When you model, ensure your high and low-poly
models are centred with each other to avoid
skewed bakes, gradients, black lines, and LOD-
issues later. Keep Smoothing Groups, UVs and
Cage in mind, and make sure your hard edges
are separated in the UV map(s) at bake time.

FOUR USE ID MAPS

Make texturing easier by creating an ID map

for easy selection and masking, especially when
using the Quixel suite. You can bake ID Maps

in Max or Maya or Substance, or you can paint
one in Photoshop or The GIMP. To avoid masking
confusion, just remember that similar colours
should never be side by side.

HARD SURFACE TEXTURING WORKFLOW TIPS FOR BEGINNERS

FIVE USE CURVATURE MAPS

Generate a curvature map for grungy texture
masking, as it renders the bends, hollows and
peaks on your model. In the map render, white
shows bends or curves —which is where you'll get
the most wear, grey is flat, and black denotes dips
or dents which is where you'll get dirt and debris.

SIXTRY APHOTO AS YOUR BASE TEXTURE

Photo-based textures will often read as more
‘natural’ to the human eye. Try using one that's
not too noisy as your detailing base. The wear on
a base like this can often have more ‘structure’
in its random components than an artificial map,
and can help your detailing.

SEVEN MIND YOUR PAINTING

Detail for usage, not coolness, even though the
concepts are not mutually exclusive. Typically, you'll
see wear around joints, on mecha hands and feet,
and wear and spillage by fuel-tanks and visible
engine(s). If you're a ready-to-renderer, mix the
shaders you bought with a curvature (convexity)map
generated in freeware map generator, xNormal.

EIGHT DECAL CONVERSIONS

Sometimes you can get great decals as
Photoshop brushes only. Save yourself the
hassle of manually exporting alpha'd .pngs
for applications like ZBrush or Substance
Painter, and automate: grab freeware abrMate
brush converter, and use it with user Asador’s
PSBrushesToAlpha script from the Substance
forums. Some of the converted files may have
softer edges than you want, but that's easily
fixed by sharpening and tweaking them in, for
example, Photoshop.

NINE LAYER IT ON

Layers of subtle build-ups always read better,
so take your time when creating your wear and
tear. Create scratches, smudges, flakings and
dents layer by layer, set to different opacities
and modes. This will read better than one big
layer of damage.

TEN AND, FINALLY...

Avoid flipped UVs on your focus areas — even
with a FBX export with tangents and binormals
checked, you run the risk of odd light and

light seams. Tris are hell to UV map, so if at

all possible, UV map before you convert and
test your model before you add it into your
game engine.
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Our expert artists share their processes and techniques
for creating amazing mechanical marvels
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odelling mechs and robots can be one
M of the most daunting tasks you can set

yourself, or have set for you. They can look
complex and highly detailed, throwing up many
questions — how realistic should it be? How much
detail do | need to include?

We've gathered some leading artists together
to discuss their recent mech and robot projects,
and to shed some light on those pressing
dilemmas that could be holding you back from
going 'full mech’. All good mechanical models
begin at the concept stage, and artist Paul Massey
is clear that kitbashing is the way forward.

"Using kitbash parts is a fantastic way of quickly
assembling your concept, it just takes some
ingenuity and a little design know-how with some
basic 3D modelling knowledge,” says Paul as he
reveals the concept model for his latest mech.
The GunDog Mech was created in under an hour
using kitbash parts bought from Vitaly Bulgarov's

website (www.vitalybulgarov.com/3d-kitbash).
The site features more than 20 packs ranging from
a few dollars up to $200 for large bundles.

"Knowing what you want your mech to do, and
how it should operate or move is key to creating
something believable,” explains Paul. “I always
ensure that any moving or revolving parts can
do just that. Any kind of constriction on a joint
or swivel point will quickly make your mech look
clunky and unusable.”

The first leg

Paul explains that he initially made a single leg
for his GunDog Mech, making sure that it would
push, pull and rotate correctly before duplicating
it four times to establish the model’s base. The
rotational body was next, and Paul reveals a neat
trick to making sure your mechanical parts work
— test them with a simple keyframe animation.
In this instance Paul created a simple rotation
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Amin Akhshi
Iran-based Amin is a

EXPERT PANEL
skilled mech modeller

o
k 4 who mixes ZBrush, Mari

and Marvelous Designer to create
unique mechanical concepts.
www.artstation.com/artist/amin

« Tor Frick
SN | Toris a 3D generalist with a
v . .
_ love for machines, working
wh  as technical art director
at MachineGames, most recently on
Wolfenstein: The New Order.
www.torfrick.com

Nadeera Gunasekara
- Nadeera is 3D modeller
©*_< A atX10 Productions, a film
& ! &= and advertising production
company based in Colombo, Sri Lanka. Their
clients include Unilever and Pizza Hut.
www.artstation.com/artist/nadee77ex

Paul Massey

Paul works in motion
graphics at McCann
Manchester. He mostly works
in TV advertising, from video editing to 3D
modelling and character sculpting.
www.artstation.com/artist/zeclipse

, Valeriy Orlov
£ With over eight years'
‘g experience in film and
video games, including The
Godlike, Valeriy is founder and art director
of Magix FX and Valart Studio.
www.valeronart.com

. Furio Tedeschi
- Furio is a renowned CG artist
-y from Johannesburg, South
~4" Africa who works in the
video games industry at studios
including BioWare Montreal.
www.smokeflames.blogspot.co.uk

Matt Tkocz
Matt is an experienced
concept designer in the film
' = industry who has previously
been a digital painting instructor at
Gnomon School of Visual Effects
www.tkoczportfolio.tumblr.com

Jorn Zimmermann
F._ ¥ Based in Hannover in
4* Germany, Jorn is a Ul
“  designer at Ubisoft Mainz
and has experience of 2D and 3D concept
design for the video game industry.
www.z-ground.com
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FEATURE
Mech marvels

¥

The level of believability is
the most important thing
in mechanical design,
which you virtually

have to represent on

your artwork.

Do not overuse references
or concept ideas. It is best
to play with different shapes
and find new ideas.

By doing so, it will assist

you in becoming a

great designer.

Making small parts does
not take much time. It is
best to create a kitbash of
your own. This can save
you time in designing
something and you can
learn plenty from it.

MODELLING THE MARS MECH

START WITH SIMPLE SHAPES

| start from a simple basic shape; a cube and a
cylinder in Maya. At this stage I'm not worried
about the details, | am just trying to figure out
how and where the parts are going to join,
and which parts are going to have movement.
It's better to use different colours for each part
and group them accordingly.

CREATE A QUICK RENDER

When I'm done with the basic mesh of my
model, | do some quick renders from different
angles in KeyShot, the real-time renderer,

to see how it's looking. Before moving on

to the next step, | have to check and make
sure each element is in the right place and
connected to the right part.

WORK ON THE DETAILS

When I'm satisfied with the base mesh

| work on details, piece by piece. For
illustrations you don't need to pay attention
to quad faces and a clean mesh. Also, you
have to be careful not to do it too much
otherwise it's going to create confusion

when you look at the model.

i T

animation of the base before moving on to create
the head, which houses the main weapon (see the

image on page 40).

“A weapon such as this would require a lot of
ammo, so | addressed this design problem by
adding three large drums of ammunition in a
unique way, which helps make the mech stand out
and, again, appear believable,” says Paul. “l then
exported the model from Cinema 4D using GoZ
to ZBrush, as | wanted to utilise KeyShot for its
ease of adding basic textures and finding a good
camera angle to display the mech at its best.”

=

MAKE USE OF KITBASH PARTS

| use some kitbash pieces around the model
to fill the empty areas. It can be helpful to
work quickly on your design and to make
new parts quickly. Sometimes | combine two
or three parts of a kitbash together to make
a new, complex, hard-surface shape and use
it on my model to have some busy areas.

USING MARVELOUS DESIGNER

For the next step, it's time to go to Marvelous
Designer and create a cloth cover to connect
the legs to the body. | import my model to
MD, but not the whole model, just the parts
that I need to connect using the simulated
cloth. When you export the cloth cover as an
.obj file, you have to use the Weld option.

IMPORT CLOTH TO ZBRUSH

I import the cloth cover into ZBrush and use
ZRemesher with the default setting to get

a clean quad mesh. Then, in the Panel Loop
menu, | use Elevation -100, Polish 1, Loops 1,
Bevel 0. Note that the thickness depends on
the size of your mesh. | then use the Move

Amin Akhshi reveals how he mixed Marvelous Designer into his mech modelling workflow

ACCURATE DETAILS IN ZBRUSH

At this stage | import the whole model into
ZBrush, and | create some cable parts with
the Curve brush. | also use the Move brush
with low intensity for greater accuracy. Then

| add some details and extra small parts with
the ZModeler brush, which was introduced in
ZBrush 4R7.

mE e

MATERIALS IN KEYSHOT

After importing my model into KeyShot, |
use a couple of metallic colour materials to
create some separation between parts. This
helps the mech'’s shapes read better. After
this | add some decals, such as the warning
signs and some text markings that | made
earlier using Photoshop.

[ B
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THE FINAL RENDER

For the final render | use Maximum time and
let KeyShot give me the best render. Before
saving the final image | go to the Passes tab
and select Clown and Depth passes. These
two options help with compositing. Finally,

| save out the render as a .png file, using the

brush to cover the parts | want to connect.

FATOWLE.

Once imported, Paul divided the model into
separate parts using Groups Split and pressed

alpha function to retain my layer passes.

the PBR button to send the model to KeyShot

plastics: “I
tosetupa
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using the built-in bridge. Once inside KeyShot,
he carefully picked a colour palette, and began to
make several groups labelled by the materials he
wanted to assign to each piece.

Eventually Paul had all the parts separated into
groups, such as main armour, bright metals and

import my chosen backplate and begin
camera angle, which | then lock and

save,” he says. "A suitable HDRI is used, taking




| add a background from an HDR map in
Photoshop. To select a part from my model,

| use the KeyShot Clown pass. You can use
the Depth pass as an alpha channel, but you
have to go to Adjustment>Exposure and play
with the options to get a depth pass that
suits. Finally, try using an alpha in Lens Blur.

into account the light source of the backplate to
add authenticity. | then rendered a beauty pass
and a separate ground shadow.”

Martian mechanoid

Amin Akhshi, a freelance 3D character artist
based in Iran, took a little more time to piece
together his latest mech project. Amin created
the mechanised planetary explorer, Observer

9 — Mars Unit (pictured above), in a month during
his spare time. Amin, whose main 3D passion

is sculpting in ZBrush, revelled in the chance to
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expand his creative horizons when modelling and
rendering a mech.

“The technical design knowledge | learnt when
| was working on this project was the part that |
enjoyed the most,” he says. As for experimenting
with new skills, Amin explains that,”for the
illustration | wasn't worried about quad faces or
clean meshes, | just wanted to set up the parts as
fast as possible. For this | used the cut tool and
the Boolean function.”

Noticing everyday details that people don't
usually pay attention to is one of the foundations

3dworld.creativeblog.com

RED ROBOT

Amin Akhshi’s martian
mech is a mixture of
sculpted forms and
kitbash parts




FEATURE
Mech marvels

The model’s materials are set up in grouped
folders, so it's a simple task to render several
passes. A Clown pass can be used for easy
selections in Photoshop. | render a Beauty
pass with an alpha channel, then a Shadow
pass by making the mech a flat white so |
can multiply the shadows in Photoshop later.

When choosing backplates | prefer a
background that isn't too distracting. Use
walls or windows to match the perspective
and then save your camera. | try to use an
HDRI that matches the lighting, and also try
and match the angle of shadows to make the
model appear situated within the scene.

|

GUNDOG MECH

“This GunDog Mech
concept art was designed
and rendered in just five
hours,” says Paul Massey

In Photoshop, | take a rough-edged brush

and pick out small areas that would be prone
to rust and scratches. Multiple faded layers
work better than one strong pass. Pay close
attention to the materials of your mech — each
element will deteriorate or suffer damage in

I used images of smoke to lift the mech from
the background and to highlight its shape.
I've also added graffiti to make it appear as
if it's been abandoned and to tie the whole
image together. | added light rays to embed
the render further, and a final weathering

Spending time to group your model’s parts will make exchanging
materials and textures a more fluid task than having to switch parts
individually. This model has over 400 parts, but grouped into five
folders for their materials. | can change each of the grouped parts’
materials without having to worry about selecting each component.
This simple organisation will greatly speed up your concept illustration.

different ways.

detail pass completes the image.

underlying Amin's art. “The level of believability is
the most important thing in mechanical design,”
he explains. Despite also being inspired by nature
and other artists in the gaming industry, Amin

is careful not to overuse references or concept
ideas. “It's best to play with different shapes and
find new ideas,” he says. "By doing so, it will assist
you in becoming a great designer.”

Eye to eye
From a giant space rover to something smaller —
artist Nadeera Gunasekara chose to focus on one

s
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mechanical component, the eye, for his project.
Nadeera uses his personal projects to experiment
and test new techniques; here he looked at how
to improve his robotic textures using Mudbox.

“l wanted to bring life to a dead thing using
mechanical stuff. So | chose the human eye,”
he says, adding that he created the sketches
mentally, and jumped straight in to modelling.

“I learned lot of things from this project,”
comments Nadeera, who used the robot eyeball
project to test his workflow, developing the
eye from low-poly concept, blocking shapes

B
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THE HUMAN EYE
“Personally, | most like
modelling robots and
mechanical stuff because
there are different and
complex shapes,” says
Nadeera. “I really enjoy
painting scratch marks
and grunge marks in hard
surface texture painting”

Matt Tkocz created this robot for the
book Nuthin’ But Mech 3. However,
the project wasn't smooth, with Matt
failing to follow his own rules: “I didn’t
figure out the robot's specific function
and It was kind of all over the place,”
he confides. “To me this piece was
mostly story-driven, which was fun for
illustration purposes but left me a little
lost when it came to the actual robot
design. Worried that the lack of purpose
would make the design too generic, |
decided to push the shapes as far as |
could without sacrificing believability.”
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THUMBNAILS

" leave no stone
unturned while forcing
myself out of my
comfort zone. There is
no such thing as too
many thumbnails,”
says Matt
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and forms, before turning to Mudbox for hard
surface textures and details. “Prior to texturing

| did research on mechanical equipment, then |
collected textures from Google. | created my own
stencils and stamps for paint scratch marks, and in
this case, grunge marks.”

When it came to creating the wires flowing from
his robotic eyeballs, Nadeera identified a number
of ways to make them: “There are a few ways to
create wires and fibres in 3ds Max. First | created
a helix under Shape Category, then | converted
this to a wire and played with the parameters of

the helix. Once done, | duplicated and rotated it
to create a bundle of around 10 new wires. | then
selected all of these wires and grouped them
together. Finally | added an FFD Box modifier and
bent it how | wanted.”

Give it purpose

Artist Matt Tkocz considers grasping why a robot
exists, its role and purpose, as a priority. Function
defines form. “In the real world all man-made
objects are created to serve a very specific
function,” says Matt. "When | come up with
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| have some simple
advice: don't rush

and always try and be
original and creative.
Start simply and build
on strong ideas.

POSING

Playing with posing helps
to bring out the character
of your robot. Here | went
for a graphic treatment.

CREATE A STORY
Thinking about corporate
identity and graphic
design is fun and an easy
way to push realism and
believability of your design.

ADD DECALS

Decorating the image

with a few phony call

outs and graphic designs
can contribute to the way
the viewer perceives,
experiences and judges the
robot design.

Practise creating new design.
Reducing a design to its essential
components, for example, will
help to sell its believability. This
Tea-Maker Robot design (bottom
left) was a practice to keep
refining shapes. Also, | avoid
humanoid robot designs
whenever possible.
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MODO MECH

This mech is one of Tor's
personal projects, which was
built and rendered in Modo
to test new workflows

NAZI WAR MACHINE
These high-poly renders
were created by Tor for the
release of Wolfenstein:
The New Order

robots | usually try to narrow down their purpose
as specifically as possible. In the real world, all-
purpose robots don't really exist — every machine
is designed to do one job well.”

Once he knows what the robot’s job is, and
what components it needs to do that job, Matt
sketches simple thumbnails at speed to "juggle
around [the robot’s] components into a variety of
different configurations”.

Matt suggests that once you've found a
direction to take your design in, you should then
spend extra time looking for ways to optimise it,
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to improve, iterate and develop the core idea.
"My first ideas are rarely my best, so everything
| do always goes through tons of iterations,” he
confides. “I do a lot of sketches and play with
different possibilities every step of the way to
make sure | don't overlook an opportunity to
squeeze every last drop of potential out of the
final image.”

Once all the important design decisions are
made, Matt switches between modelling, further
sketching and posing, “while slowly massaging
the piece to finish.”

creativeblog.com




ock formations and so on.
hen mixing retro references and mechanicals, is
there a knack to making them work in harmony?
One of the mistakes that's easy to make is to combine
too many different references. If you draw inspiration

from too many sources it's easy to dilute the style you're

going for if you're not careful which elements you bring

in. If you want to mix things as it is, combining retro and

mech design, it helps to focus on a few strong aspects.
It's easy to create a cluttered design by simply bolting
lots of small elements on top of an existing mech core
design, instead of merging the two.

What was the biggest challenge when creating
mechs for Wolfenstein?

The biggest challenge was to build something that
looked visually impressive, while still being able to fit
within the technical limitations (a very low polycount,
for example). The robots have destructible armour so
they needed insides as well, and it all had to fit within
the polycount. | needed to adapt designs on the fly to
simplify shapes for the low-poly version to work.

How much planning is needed when working on a
mech model, particularly for video games?

Not that much. | normally start out by making a complete

functional blockout of the model, so | can iron out any
rigging or animation issues early on. This model is very

simplified while still containing all the major shapes and
features. It's very quick to make and allows for very quick

iteration on design problems. After that, | can just start
digging into the modelling without having to figure out
too much along the way.

What advice can you offer to readers looking to
mix influences in their mech models?
Focus on strong influences that are easy to read, such
as larger shapes, materials or unique design attributes.
Repeat those influences across the model — you want
it to be a theme, not an alien element. It's easy to add

minor influences and think they’re obvious, as you're the

one who added them. Someone looking at your model
for the first time is likely to miss or misinterpret them.

BTG R ST e T
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Form following function

The purpose of a mech or robot is as key to Jérn

Zimmermann's modelling as it is to Matt's — once
again the function of the model inspires its design.
In fact, Jorn sees this as the thin line between a
great robot model and an average one, pointing
out a common mistake for many models is their
inability to move and flex joints.

“Sometimes the models look cool but when
you take a closer look, they could never turn their
head or flex or rotate an arm. Of course, | have
been guilty of this too! That's why | try to improve

E

Do you always start with a
pen sketch when sculpting
robots. If so why?

No, not really. | try to use

any method that helps me —
sometimes it's sketches and
sometimes it's just jumping
straight into a 3D package and
working up ideas and forms.

What is the advantage of
using IMM brushes?

The advantage is that they can
speed up your process for the
minor details or background noise
on your hard surface model. [You
can download Furio’s IMM tech
parts used for the ZBrush Summit
2015 from this issue’s Vault.]

S .'\5:_-'

on this, among other areas. Nowadays, | try to be
aware of what the purpose of the robot is and how

ARTIST Q&A: FURIO TEDESCHI

Do you create your own
custom IMM brushes? Can you
offer any advice to readers
when using IMMs?

Yes, | like to create my own but
also use others' IMM brushes.

It's good to use IMMs but don’t
let them dictate your design, as it
might start to look like the work
of the IMM brushes.

What do you make of the
Toon Shader in KeyShot? Is

it good to experiment with
these features?

It's good to experiment with any
of the features in KeyShot, as

you might not know what to do
with them unless you play around

SOFTWARE BUG
Furio sculpted this
robot Mantis for
2015's ZBrush Summit

with them. Plus, the Toon Shader
is super fun and gives a nice
traditional artwork quality to the
CG renders.

What do you think is the
advantage of using KeyShot
for robot sculpts?

KeyShot is very quick and
simple to use. It helps with
quick material setups and
lighting solutions, but there's
no real advantage to using it for
rendering robots.

Watch Furio's video training for
hard surface modelling, in which
he sculpts a Japanese-style robot:
www.bit.ly/205-furio

e 8D TR N A RPN AR R

Sometimes the models

it's supposed to move,” says Jorn.

Software of choice for Jérn is ZBrush, and he
chooses to use DynaMesh spheres and standard
brushes for the more organic parts (Move, Clay
Buildup, Trim Dynamic, hPolish, Dam_Standard,
Trim Curve).

“A set called MAH Brushes, offered by MAH
Studios, is also really helpful for hard surface
sculpting,” advises J6rn, adding that for the
mechanical parts, he often uses IMM (Insert

look cool but when you

take a closer look, they

could never turn their head
or flex or rotate an arm
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Valeriy Orlov's Weapons For Peace is an
open-source project that he hopes will
inspire artists to rethink how weapons
are used and created. “Weapons must be
used in a very limited case and only as a
demonstration of force, aiming to protect
civil people and not as an act of physical
aggression to pursue someone’s selfish
goals,” says Valeriy. In a sense, he wants
artists to create ‘defensive weapons'.

His initial robot concept is the MMCS
RATNIY M09, created as a modular design so
artists can see how each piece fits together
and can be developed in new directions.
"This character is simple and can be easily
understood by everyone. | think that it's not
quite the right strategy to start a big open-
source project with complicated characters,”
says Valeriy.

Valeriy explains his concept process
and encourages you to adapt and reinvent
his idea into something else. Can this be
turned into a weapon for peace? A medical,
construction, or agriculture robot, perhaps.

Jorn Zimmermann's android design,
'Prototype’ is one of many robot
concepts to be found on his website

| didnt want to create something futuristic; | wanted to
create a character anyone can believe in, which means
it should consist of known forms. So | took photos at an
outdoor museum of military machines for reference.

RRR

Having gathered all necessary material, | began working. It
took some time to discover how my references and shapes
fitted together, but very soon | figured it out, and the first
concept silhouette appeared.

Once | had the forms and design in place | began thinking
about how the mech should walk, bend, carry weapons, and
so on. This required another round of reference gathering,
focusing on smaller elements and details.

Multi Mesh) brushes and tries to build believable
mechanical elements out of the parts.

Jérn recommends using a combination of
DynaMesh sculpting and IMM brushes to speed
up your mech blocking-in process: "I think
getting used to ZModeler efficiently could
improve the workflow. Also, | found the new
Autodesk Fusion 360 quite interesting to speed
up the process for the mechanical parts... and of
course, practise is key!”

Once you have your mechanical creation
modelled, its form and function set, it's time to

3D WORLD March 2016

Once I'd devised how it's going to move and work, | divided
the design into parts and thought about how a robot like

this will be manufactured. This included designing the main
processor, as well as different safety and life-support systems.

layer on the extra details that will bring those hard
surfaces to life. Valeriy Orlov turned to Photoshop
to create his decals, brands and designs for his
Weapons For Peace project. He says approaching
decals is a matter of thinking big, imagining a
world around your mech.

Devil in the decals

"You need to think about logos of imaginary
companies thoroughly to make sure your robot
doesn’t look handcrafted, like it was created in
some garage by local guys,” explains Valeriy. "You

3dworld.creativeblog.com



JOLLY GREEN GIANT
Valeriy Orlov’s war robot
takes influence from
Russian military hardware
and Japanese mecha

As well as thinking about the shape and design of a military
robot, | also created the weapon design. | thought over
everything, from the number and shape of the bullets to the
technical characteristics needed to achieve a realistic concept.

| considered the armour colour and additional asymmetrical
details that will make the robot look realistic, as well as logo
locations on the final stage of the concept. All that was left
was to insert the concept into an environment.

need to make sure it's a part of a huge industrial "And remember,” adds Valeriy, "whether you
production. You need to think what goods your are working on a single concept or a big project, YOU HEEd tO thlnk abOUt
imaginary plants make, how they work together, the main goal of the markings and logos is to : ;

what components they provide and who will be create the feeling of a whole new imaginary I.OgOS Of lmaglnary

the main publishing brand.” world around your character, not just to place i :

All the images you create should be in one cool-looking decals all over it. It's necessary for Compames thoroughly tO
style, they should blend together in one piece. the audience to believe in your character. You
To this end, Valeriy suggests looking through a shouldn't save your time and strength on this. No make Sure y0UF TObOt
number of various industrial references, with real matter how difficult it is and how much time you - .
marking logos on their components. This will help  spend, this is your final touch.” d[]esn t lOOk handcrafted
you to create realistic images and place them on 5 Download IMM brushes and step art from
the right parts of your concept. H_ www.creativeblog.com/vault/3dw205

B

B
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TUTORIALS

Practical tips and tutorials from pro
artists to improve your CG sKkills

H

54 GET STARTED IN QUIXEL2 60

Top tips to master the latest texture app Part 4: Create and apply texture maps

GET YOUR =
Sd=o{@ 0] 1 (e =50 /3 MASTER MECH MODELLING 42 CREATE FOLIAGE FOR ARCH-VIZ

You're three steps away from this Create a tank-inspired walking mech Ryan Groves shows how to use 3ds Max plug-ins to create detailed vegetation

issue’s video training and files...

1. GO TO THE WEBSITE
Type this into your browser's address bar:
www.creativeblog.com/vault/3dw205

2. FIND THE FILES YOU WANT
Search the list of free resources to find
the video and files you want.

3. DOWNLOAD WHAT YOU NEED
Click the Download buttons and your

fles will save to your PC or Mac. 70 IMPROVE YOUR SCULPTS 76 GROW REALISTICTREES 76 CREATE A DYNAMIC DRESS

Add personality to your 3D art Get started with Blender's new plug-in Master the Marvelous Designer 5 process
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TUTORIALS

Mech modelling skills

IMPROVE YOUR MECH
MODELLING SKILLS

Tomi Vdisdnen shows how to design, model and
render a tank-inspired walking mech

ARTIST PROFILE
Tomi Vdisdnen
Tomi is a 3D artist
at Ubisoft RedLynx,
and is from Helsinki,
Finland. Working in
the advertisement
and game industry
for several years,
Tomi also fits in
personal projects
when he can.
tomivaisanen.com

TOPICS COVERED
Modelling
Materials
Rendering
Compositing

my workflow for creating a

convincing and detailed mech,
scarred by battle damage and
completed with worn, grime and
grunge textures. | will guide you
through all the steps, starting from
the gathering of reference images,
which will give you a clear vision of
where we are going. After that, |
will plan and sketch out the model
in 3D primitives.

I will show you how to survive
the stress of crunch time by
speeding up your process. |'ll also
share my process for modelling
complex forms with standard
poly-modelling tools, as well
as generating some nice wear
and tear automatically — without
having to unwrap that much —to
speed up your workflow, without

I n this tutorial I'll explain

1 BLOCKOUT AND FIND SHAPES

| start by blocking out the forms simply by bashing

all the different primitives together. Scaling them up
and down, bending and using FFD modifiers from 3ds
Max. There's no need to worry about anything else
other than the overall silhouette. To balance the whole
object, keep checking the measurements and sizes of
different parts. Use different perspectives and views to
see through the mess of blocks and begin to develop

a vision for your final image.

compromising on quality. | will talk
about the importance of kitbash
assets and how to implement
those to your model.

For the rest of the tutorial | will
focus on compositing my model
to make it look really realistic.
We'll look at blending modes and
creating those happy accidents
that can lift your mech model to
the next level. The challenge of
modelling a mech like this is the
sheer volume of work. There's
lots of things that need to work
out correctly for the design to be
plausible — from the main form to
the tiniest detail. Modelling this
piece of work took me a few weeks
and most of the time was spent on
just plain modelling.

To follow this tutorial, you
should have a basic knowledge of

the production of 3D modelling,
because | won't cover all the tools
and details. We will be using 3ds
Max, Corona and Photoshop. |
hope you will learn something new,
or at least get inspired.

My inspiration for this mech
came from the Maschinen Krieger
model kits. I'm a huge fan of big,
rusty and battered war machines
that make me want to dive in and
model every nut and bolt. But first
we need to gather references.
Besides the Maschinen Krieger
models, | also gather images
from old Vietnam-era tanks.

Keep in mind, references for hard
surface modelling can come from
anywhere, because it's the forms
that matter most. So let’s begin.
For all the assets you need go to
creativeblog.com/vault/3dw205

2 BEGIN MODELLING

| start this model in a very uncommon way: by
completely modelling the left leg first and ignoring
everything else. This is because it is the most detailed
and complex part of the whole model. Part by part,
starting from the groin, | work down to the foot. When
modelling mechs you need to think on a deeper level;
don't view it as flat pieces of armour and consider the
mechanical parts behind the plates, like the hydraulics,

cables and sensitive parts the armour hides.
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" TANK-INSPIRED MECH
‘ Maschinen Krieger
ko models heavily

Ny . influenced Tomi's
mech creation

-
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TUTORIALS
Mech modelling skills

START

SIMPLY

MODELLING
COMPLEX FORMS

ONE BLOCK OUT PRIMITIVES

Intersect the forms you want
together and make sure that
loops match as closely as
possible, and there's enough
geometry to maintain.

TWO ATTACH AND EDIT

Attach geometry and delete
unwanted edges. Get the edge
flow to match the main form. I keep
small gaps between geometries to
help bridging and welding.

THREE BRIDGE AND CLEAN

Bridge geometry together and
make support loops. You may need
to move vertexes by hand. Keep
constraints on for faces. Check
geometry works with subdivions.

5 MODELLING DETAILS

By looking at my reference images, | have a clear
idea of what kind of detail the model needs. | could
easily spend a day or two just modelling these
different assets. They will also make a nice addition
to your personal kitbash library. I'd recommend
modelling every individual part in high detail
because you may need it later — either on this project
or another mech model. Always think of these assets
as a set, too. For example, model more than you

3 USE A SKELETON

The hydraulics act as a skeletal structure that | build
around. | start with the primitive that represents the
closest form I'm after. Then | use the Edit Poly modifier
and refine the shape. | use the Extrude, Cut, Weld,
and Swift Loop tools to create the forms. On the
modifier side of things, Symmetry, Shell, FFDs and
TurboSmooth are the most common tools. Normally

| stay with standard poly-modelling and rarely use
booleans as they tend to break up the geometry.

4 MODELLING BIG PARTS

Being a symmetrical form, you only need to model one
half of the mech. | use the blockout model as a base
for this main model. Some areas require more work by
moving vertexes by hand (using constrains and snaps),
but mostly | use the quad geometry. It's also important
to use enough geometry to get the forms as you like,
but still keeping it manageable. Occasionally | use

the TurboSmooth modifier to clean up the geometry
before continuing with the Edit Poly modifier.

Build your personal
kitbash library and
take a good care of it.

Whenever you finish a
new project, pull that to
pieces and add them to
your kitbash library.

need; three bolts instead of one just for the case

of variation. These details can be done in the same
work file but on a different layer. Besides having a
large kitbash library for yourself, it's also really useful
to have these pre-made forms — such as difficult
bevels or cylindrical forms at weird angles —in a
planar surface. These can then be easily added as
part of your mesh or become a starting point for a
new mesh. Small workflow patterns like this can save
a lot of time in the long run.
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6 KITBASH LIBRARY

The mech is covered with all sorts of details, like
nuts, bolts, handles and plating. This is where having
your own kitbash library helps - it just doesn’t make
any sense to model the same screws and handles
again and again. By looking at my references, |
analyse the distribution of detail. What are the areas
with lots of it and where to not put any. | use the
Select and Place tool in 3ds Max to add the bolts
across the surface.

7 UVW MAPPING

Most of the time | simply use standard box, planar
and cylindrical mapping with procedural and tileable
textures. There's usually no need to unwrap every
piece and even the larger forms can sometimes be
cheated to look good without unwrapping anything.
For speed | sometimes just fix those large seams at
the compositing phase. The only elements | unwrap in
this model are the main hull base and all of the hoses.
The hull is textured using Mudbox and Photoshop.

Map #1814

USE KITBASH SPARINGLY
| find it important to not
‘model’ everything by
kitbashing because it will
make all your models look
too similar and messy

8 USING SHADERS

For shading and rendering | use Corona Renderer.
Corona is really responsive, modular and shading
with it is fast and fun. | have this self-made base
shader that | use for everything. The base idea

for the shader is to automatically generate rust
and worn edges by using ambient occlusion as

a mask. A base material is whatever you want it

to be, in this case it's a painted metal surface.

The rust shader is simply heavily bump mapped

with worn edges and has a really glossy, almost
mirrored surface shader. To get these nice grungy
and uneven edges between occluded and
unoccluded colour, | break it up by using a high
contrast and tileable black and white bitmap, so
this acts as a base. All the different materials in this
scene started by using these same base shaders.

| add this to my material library and will load it in
when needed, just like all the other good looking
materials for this project.

9 LIGHTING THE SCENE

The mech is being placed in an overcast environment
and there's a snowstorm going on, so | want to keep
the lighting very simple. The majority of the light is
coming from the HDRI map, but there's also a subtle
blue backlight and small fill light in the scene to

make those forms pop out more. Also, the ground

is covered with white snow, which will act as a big
reflective surface to give me a lot of bounced light
from below and liven up the shot.

3D WORLD

10 SETTING UP RENDER PASSES

To make things easier to composite, it's necessary
to have really good masks. Usually these masks
are easily achieved by having different object IDs
and Wire Color render passes but here | also use a
few extra passes, such as ambient occlusion, faked
fresnel reflections and wireframe. If fake fresnel
sounds scary, it's just a standard falloff map that
gives highlights to an object’s edges. | find this
useful to use when refining forms.

March 2016 é www.youtube.com/3dworld

| cannot stress this
enough. Take a break
now and then and do

something else. You'll
spot the mistakes in the
model you have made
so far, and it also

helps to keep you
motivated.



TUTORIALS
Mech modelling skills

Rendering in Corona is
straightforward. You can
get good results with the
preset settings without
optimising everything

11 START RENDERING

Rendering in Corona is straightforward. You can

get good results with the preset settings without
optimising everything. But in complex scenes with a
lot of bounce light you may want to adjust the Max
Sample intensity and Max Ray Depth sliders. | don't
like to render camera depth of field because it can
be hard to adjust afterwards — and that’s why we have
passes. For faster results use progressive rendering
limits, using the Rendering Pass limit or Time limit.

Have a wide selection
of tileable high

contrast black and
white textures

to use as masks
for different
materials.

12 BEGIN TO COMPOSITE

Even though | rendered all the passes, | only use a
couple of them for these images. First of all | load in
my standard beauty pass, masks and alphas. | make
correctly named folders for them to make things
easier to navigate. Next | separate foreground,
background and the mech model. I'd advice you to
experiment at this stage and try all the passes with
different blend modes, because trial and error can
lead to some amazing ‘happy accidents’.

PERFECTING YOUR WORK p
Continue to tinker with your
mech. Make sure you don't
have overly black or white
spots that can ruin the balance

14 FINISHING TOUCHES

In the end, all that is left is the final colour
correction. | apply Copy and Merge to the whole
image and add depth by using a ZDepth pass.
Even at this stage I'm still tinkering with the mood
by experimenting with different colour variations
using gradients and blend modes. Finally, using
Levels and Curves, | ensure the final image has
equal blacks and whites, so there’s no overly dark
or white spots ruining the balance. m

13 THE OVERPAINTING PROCESS

When working with still images, | like to overpaint

alot. I first look at the UVW seams and fix them
(boxmapping can sometimes leave little scars). When
painting with standard brushes it's tempting to add
worn and teared edges everywhere, but go sparingly.
At this stage | blend in photo textures using Overlay
and Softlight blend modes. Be careful at this stage;
good use of textures can make your rendered materials
really pop but overdo it and it can ruin your work.
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TUTORIALS
Master Quixel Suite 2

ARTIST PROFILE
Wiktor Ohman
Wiktor is an art lead at
Quixel and has a
background in video
game art with studios
such as Star Vault

and Ubisoft Massive.
www.artbywiktor.com

Press [Shift]+[Space]
regularly to refresh

your normals and
show your new
texture work in
an instant.

TOPICS COVERED
Edit normals

Add details

Paint textures
Customise materials
Quick render

1 oueLsurea piosio>
GET STARTED
IN QUIXEL SUITE 2

Wiktor Ohman shares his tips to master the tools to quickly improve your normal
maps and texture detail, with the new industry standard Quixel Suite 2

uixel Suite 2 is the latest
version of the industry
leading texture painting

suite that comprises three main
applications, NDO (for creating
normals), DDO (a real-time
texture painting tool) and 3DO (a
physically-based renderer). While
the suite offers many easy-to-use
features, in this tutorial | aim to
introduce you to the core workflow
to get up and running in the suite
of apps. But firstly, let’s look a
little closer at those tools...

=

1 SET UP A PROJECT

NDO enables you to specify the mesh, as well as
the Baked Normal, to see the changes made in

real time in the 3DO previewer that ships with the
SUITE. Start by selecting Launch NDO Project
Creator>Mesh>Baked Normal and select your .obj
file. Once imported, select Create New Project. To
add a new detail to an existing normal map couldn’t
be easier. | choose to add a vent to the engine

section of my speeder.

0

NDO allows you to use any tool
in Photoshop to create non-
destructive normals, including
shapes, paths, strokes, selections
and photographs. It uses all the
tools to create normals quickly,
including tiled designs, converting
photos to rich normals, and quickly
adding details to existing normal
maps. My tips cover detailing an
existing normal map and mesh.
DDO is a PBR texture painting
tool used inside Photoshop to
create highly detailed textures

CLICK TO PLAY VIDEO

wwwbit.ly/205-quixel

FOLLOW.
)

If you see the Play icon,
use the link!

THE

very quickly. It's been developed
for artists by artists, so it's a really
intuitive tool designed to make
texturing easier.

Once your texture work is
complete you can create a
presentation render of the model
in 3DO, a powerful physically-
based renderer inside Quixel Suite
2.0. It comes with various camera
post-processes designed for
presenting your model.

For all the assets you need go to
creativeblogq.com/vault/3dw205

2 USE EXISTING NORMAL MAPS

3D WORLD March 2016 é www.youtube.com/3dworld

| begin by selecting the Shape tool and set it to
arounded rectangle; this is the base shape of

the vent. | close down the 3DO previewer to see

the normal map. Next | create a New Sculpt layer
and the rectangle Shape is created into a normal
automatically. All I need to do now to get the normal
detail, and create my vent panel, is to drag out the
shape and rotate to fit existing details.
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TUTORIALS
Master Quixel Suite 2

B & 5 Sculpt Layer (Ed

Shape Bevel Slant Curve Blend

Contrast
Opacity
Sofiness &
Falloff
Anti-alias &
Z-factor
Planefill

- " e = e

USEFUL TOOLS

| like to adjust with the Smudge
tool. once the shape is set, to
make it match your existing baked
normals, select the Smudge tool
to skew the edges slightly. Also,
use detail with the Bevel tool.

To tidy your new normal, use the
Bevel tool and set it to Groove

to narrow the indent and fit the
existing baked normals.

SPEED UP YOUR
PROCESS

Once you've set your new normal
into an existing baked normal,
select the Zip button at the
bottom of the In Sculpt Mode
panel to zip it up. This saves
space and improves performance
(it's non-destructive and can be
unzipped at any time).

3 QUICK DETAIL

To create venting holes on top of my vent panel, | select
the Marquee tool and create a panel by dragging on
the normal. | duplicate this panel by selecting and
[Alt]-dragging, then rotating to fit. To convert these
new panels, simply hover your mouse over the NDO Ul
panel to see it change to the Layer panel, then select
the option to convert the active layer to a normal. Next,
| select Slant>Down to make the vents look like holes,
then smooth the vents by adjusting Size and Softness.

4 CREATE SURFACE DETAILS

Begin by copy and pasting a photo into your normal
layer and place it roughly over the area you want to
detail — in this case the wing of the model. To see
where the underlying details are, reduce the opacity
of the photo. Use the Polygonal Lasso tool to make
your selections, then Invert and Erase. Push the
Opacity slider back to 100 per cent. Once done, click
the Convert button to turn the photo to a normal.
Again, it uses the same underlying settings.

Contrast
Opacity
Softness & .

Fallof { I8 §

Anti-alias & i . /!

5 BLENDING SURFACE DETAIL 6 MULTI-NORMALS

Use the slider settings in the NDO Ul panel to tweak  Multi-normals is a new feature that enables you to

your photo normal. | adjust the Size and Falloff quickly add lots of details, with different parameters,
sliders to make the photo detail more subtle, and so you don't need to go back and forth between

then go to Blend>Overlay to enable the underlying normal groups. You can use different Photoshop layer
shapes to come through. Next | reduce Opacity to types in combination with multi-normals, such as using
50 per cent. Enter 3DO Previewer and press Refresh  the Brush and Pencil tools to hand-paint normals or

to preview and Zip to keep things tidy. the Shape and Pen vector tools. You can also use the

Text tools to convert text to normals instantly, enabling
you to change font and size with ease.
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9 SETTING UP IN DDO

Launch DDO Painter and open the Base Creator,

this is where you can set up your project by hooking
up your mesh and map inputs. Using the Quick-
Load inputs option hooks-up inputs automatically

- providing they follow the same naming convention.
I tick the Bake in 3DO options on the Object Space
Normal, Curvature and Position Gradient tabs. Next |
set the resolution to 4K (you can upscale at any time,
3DO also supports 8K).

7 USING NDO PAINTER MODE

Multi-normals also enables you to enter 3D
painting, allowing you to paint and sculpt normals
directly onto your model or mesh. Simply click the
NDO Paint mode tab in the NDO Ul panel to open
a new Painting tab. Using a simple Hard Round
brush, and holding [B] and right-clicking to change
the dimensions, | paint in a panel detail. Just like in
Photoshop, hold [Shift] to get straight strokes with
the brush.

8 MULTI-NORMAL LAYERS

Click the new layer icon and in the same normal
as before we can start adding text; simply click
the Text tool and begin typing. The words are
automatically converted into a normal. You can
change text, rotate and resize at any time as it's
non-destructive. Next, on the same normal layer,
| click the Shape tool and add a vector shape
under the hinges. Open 3DO and refresh to
preview the changes.

10 EXPORT TARGET

You can export to any number of pre-defined apps,
for example if exporting to Unreal Engine simply
click the UE4 tab under the Export Target drop-
down menu. This means your texture and shader
setups follow the same standard as Unreal, for
example using AlbedoM, Metalness, Roughness
and Normal. Finally, all you need to do is click
Create to continue.
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Press [Shift]+[Space]

to preview your
painted normal. To
preview without the
mask overlay, press
and hold [N].

FRESHEN UP YOUR
WORKFLOW
QUICK WAYS T0
WORK BETTER

ONE EDITING LAYERS

A simple trick to go back and edit
a layer in your normal is to enter
Sculpt mode — second button on
the left in the NDO Ul panel. You
can enter Sculpt mode at any time.

e

TWO WORK ON SMALL DETAILS

Use the Brush tool in Photoshop
to add small details to an existing
normal map. If working on an
existing normal it will use the
same layer settings for speed.

THREE USING SCULPT LAYERS

Remember, anything added to a
Sculpt layer is instantly converted
to a normal. When you exit
Sculpt mode, it automatically zips
your file to reduce file size.
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Master Quixel Suite 2

When hand-painting,
pressing [M] will allow

you to preview the
strokes in a clearer
way by removing
the textures.

ADJUSTMENTS
Clicking Roughness and
reducing the slider by
50 per cent will make

it glossier

12 CUSTOMISE YOUR MATERIAL
For a sun-bleached effect click DDO>AlbedoM>Add
Clean Layer (on the bottom bar). Hold [Ctrl] and click
Add Clean Layer sets the Blending mode to Overlay.
Click the colour swatch to open the Color Picker panel
and make it slightly yellow. Enter Dynamask mode by
clicking on the left panel in the Color Overlay tab to
begin painting in full shaded mode. Here | loaded the
Sun Bleach Heavy preset and increased the Tightness
slider to 70 per cent and click Accept Mask.

14 USING MASK ID

Holding the [C] key will instantly show the ID map.
From here you can click on the area you want to
work on and by holding [Shift]+[C] you will open the
Material Browser. From the browser | choose to add
a smart material. | select a metal material from the
presets and press the Create button to add and zip
the material.

11 BUILD MATERIAL DEFINITION

DDO works with a large amount of physically-based
scans and smart materials — multi-layered textures
with dynamic weathering that react to the shape

of your mesh. To add a smart material, click the
Material Browser icon and search through the
presets until you find something that fits your
project. For my speeder, | choose Metal>Scratched
Painted Metal for a worn looking material, and

click Create to apply.

13 COLOUR HAND-PAINTING

The Painter allows you to paint anything at anytime
across all maps. Click Add Color Paint Layer to begin
and access the colour options from the Painting panel.
Here | begin painting out some colour highlights in a
yellow-orange tone, on a low opacity to get a dynamic
build-up of paint from my strokes. | also add some
darker reds to add more depth to the crevices of the
engine. Click the Paint icon on the Color Paint Layer in
DDO to exit paint mode and save your custom changes.

15 DESIGN THE DYNAMASK

Next | want to add grime into the crevices by
loading a single surface scan. Go to Material
Browser>Coarse Rust>Create. Hover over the
Coarse Rust layer and click Edit Dynamask, then
choose Metal Grime from the presets. Now tick
the Show Advanced tab to expose and edit the
advanced parameters of the mask. | start by
tweaking the Tightness of the AO influence to
around 70 per cent on the slider.
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16 ADDING GRIME

Now | want to add some grime to the front caps.
This can be done by painting directly onto the mesh.
| open the Grunge Brush panel from the Painting
panel, then choose a preset Brush Tip Shape; Size:
124, Spacing: 10, Angle: 0.00, Roundness: 1.00. You
can paint directly into the Dynamask and once done,
press Accept Mask to apply.

19 TWEAK THE RENDER

I like my render but feel it needs some final
texture details. | want to add some soot and dust
around the engine, directly to the final render.

To do this, click the Color Paint layer (small

brush icon in the DDO panel) and click on Paint
Layer>Painting>Brushes>Grunge. | choose a
brush with some directionality and, keeping the
opacity low, | paint on the soot directed away
from the engine.

17 ADDING LEATHER MATERIAL
Hold [Shift]+[C]-click the seats to open the Material
Browser and select the Leather material preset and
apply to add the leather materials to the seat model.
| want to also add a leather material to the outer
edge of the seat, so select the Leather group and
hold [C]+[Ctrl] to add another ID. | want a material
separation between the two while still keeping the
material type, so | add a new Overlay layer, change
the colour and link it to the outer area of the seat.

You can always
tweak materials non-
destructively as you
paint by adjusting
the Opacity,

Texture Intensity

and Scale.

Open the Options menu and tick Post Process to see
the default 3DO Post Process presets. You can then
adjust the settings to suit, these include Intensity,
Color Bleed and Brightness. 3DO also comes with
preset defaults for different uses. For example, under
Post Process presets | click the drop-down menu and
set it to Fine Presentation. | like to increase the size of
the 3DO viewer to get a better look by click-dragging
on the bottom right corner of the viewer.

o

20 ADDING ROUGHNESS

Finally, I want to enhance my painted soot strokes, so
| click Roughness in the DDO panel, select a Leakage
brush, rotate and resize, and then paint over my soot
strokes. | toggle Color Paint mode off and take a
look at the new render in full screen mode. m
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STILL LIFE PART 4:
TEXTURE MAPS

In the final part of his render series, Bhaumik Patel shows
how to create and apply texture maps to the still life scene

<

ARTIST PROFILE
Bhaumik Patel
Former Escape Studios
tutor Bhaumik has
created Amaya Academy,
which offers a 30+
hour online course in
Maya for visual effects
and animation to get
you from beginner to
professional level.
amayaacademy.com

AMAYA

ACADEMY

TOPICS COVERED

Cloth and wood textures
Reflections

Texture maps

rendering in Arnold for Maya,

we will finish off our scene by
applying texture maps to the
remaining objects. Texture
maps are highly optimised
inside Arnold.

When you press render, Arnold
performs some operations on
your textures. It automatically
creates smaller versions (these
are known as mipmapping), and
tiles them for better memory
efficient access.

This allows Arnold to deal with
massive scenes efficiently and
allows it to anti-alias the scene
quicker. With larger textures this
will appear to be a slight delay
before rendering.

You can save this step by
turning off those features.

Go to Render Settings>
Arnold Renderer>Textures

| n the last part of our series on

section, and then turn off Auto
Tile and Auto Mipmap.

For larger scenes it's best to
use these features and you can
pre-calculate your textures and
save them as .tx files. You can
do this easily using Arnold>TX

If you see the Play icon,
use the link!

section after you have created
your textures.

We will be making wood,
metal and cloth. Cloth is a diffuse
material and has a slight highlight
on the edge. Wood is generally
treated so it has a shine with

When you press render, Arnold performs some operations
on your textures. It automatically creates smaller versions
and tiles them for better memory efficient access

Manager. TX Manager will find
all the textures in your scene
and can select the ones you
wish to convert and click the
Create .tx button.

However, be sure to turn
on Use Existing .tx Textures
in the Render Settings>
Arnold Renderer>Textures

3D WORLD March 2016 . www.youtube.com/3dworld

plenty of breakup in the
highlight where the grain is.
Metal is very reflective and can
be a sharp reflection such as
chrome or blurry. Like a brushed
chrome, because it's reflective its
diffuse colour will be very dark.
For all the assets you need go to
creativeblog.com/vault/205
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1 TABLE CLOTH TEXTURE

So first, select the cloth object, right-click and select
Assign New Material. Create aiStandard from the
Arnold section and rename it cloth_shader. Let's
map the diffuse colour by clicking on the checker,
pick file. In the file node click on the folder icon

and pick cloth_color.tif (download from the online
Vault). Do the same for the bump map and pick
cloth_bump.tif. Set the Bump Depth to around 3 and
increase the diffuse weight to 1.
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3 CREATE THE WOOD HANDLE

The knife isn't all metal, so we need to make the
handle a wooded texture. Start by selecting the faces
for the knife handle and assign another aiStandard
shader. Rename this wood_shader. Now, map the
diffuse colour with knife_wood_color.tif (download
from the Vault). Add some highlights to the wood, set
the Reflection Weight to 0.034 and map the reflection
colour with knife_wood_specular. You can increase the
Reflection Weight to make it look less weathered.

5 TURN ON TEXTURES

Now that we have set up our shader with texture maps
let's create our optimised .tx files. Start by opening
Arnold>Utilities>TX Manager and you will see a list of
the textures in your scene. Click the Select All button
and click the Create .tx button. We need to tell Arold
to use these textures, so in the Render Settings go to
the Arnold Renderer>Textures section, and turn on the
Use Existing .tx Textures check box.
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2 METAL REFLECTIONS

Begin by selecting the faces for the knife's blade

and assign a new aiStandard shader, rename it
metal_shader. Let’s set our Diffuse Weight to around
0.06 and Diffuse Colour to a dark grey. Set Reflection
Weight to 1 and map reflection colour with knife_
metal_specular.tif (download from the online Vault).
This will make the reflections bright but we don't want
them to take over the image, so let's diffuse them by
setting Reflection Roughness to around 0.65.
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4 CHEESE BOARD

Open the hypershade and duplicate your wood
shader using the Edit>Duplicate command. Rename
it cheese_board_shader and assign it to the cheese_
board object by middle mouse button dragging and
dropping onto the object. Replace the diffuse colour
file with cheese_board_colortif (and specular colour
with cheese_board_speculartif). Both files can be
download from the online Vault. Finally, tweak the
settings by increasing the Reflection Weight to 0.2.

6 FINAL ADJUSTMENTS

Let's remove the grain by increasing the samples

on our area light to 5. In Render Settings>Arnold
Renderer>Sampling, increase your AA samples to

5. Have a look at the render and if there is grain in
specific areas, such as SSS, then increase the samples.
Set the SSS and Diffuse samples to 3. You can
increase AA samples further to reduce grain. m
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CREATE A USED LOOK
Be sure to increase the
roughness value to blur
the reflections, giving a
more used and less

CGl look

IMPORT TEXTURES
Keep it simple

A nice way of importing textures
is to simply drag them from your
explorer or finder window into
the Hypershade. This will create a
file node for all the textures and
name them the same as the file
name. You can then use the TX
Manager to create your .tx files
before you start. The textures will
be located in the same folder.

WATCH YOUR SAMPLES
Be sure to increase AA
samples sparingly as this will
increase the overall render
time exponentially
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~ 3DSMAX | V-RAY | GROWFX | FOREST PACK

CREATE VEGETATION
FOR ARCH-VIZ

Ryan Groves shows how to model, texture and scatter detailed
vegetation for use in architectural imagery using 3ds Max plug-ins
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PLANT MODELLING
The GrowFX plug-in helps
to bring a level of craft,
originality and versatility
to your workflow

CLICKTO PLAY VIDEO
www.bit.y/205-veg-1

o

CLICKTO PLAY VIDEO
www.bit.ly/205-veg-2
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CLICKTO PLAY VIDEO
www.bit.y/205-veg-3
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CLICKTO PLAY VIDEO
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CLICKTO PLAY VIDEO
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ARTIST PROFILE
Ryan Groves
Ryan is a 3D artist at
The Neighbourhood,
Manchester. He has
a passion for detail,
mood and lighting,
and strives to
create evocative
imagery that
conveys narrative
and emotion.
ryangroves3d.com

Ifyou see the Play icon,
use the link!

TOPICS COVERED
Modelling
Texturing

Painting

scatter areas
Generating ivy
Poly-modelling
techniques

system such as GrowFX into your

skillset can be extremely valuable.
Modelling vegetation can be an
arduous and difficult process that
GrowFX helps to simplify with a
parametric approach. Many times
I suffered with my limitations in
this area of modelling, should a
client require a bespoke piece of
vegetation | couldn't piece together
from our library.

The benefits of learning a plug-in
like this are huge, and it can bring
an extra level of craft, originality
and versatility to your workflow.

I ncorporating a plant modelling

I modelled the building in this
scene on Refuge, in Belgium, by
Wim Goes Architectuur. In this
tutorial, I'll take you through my
workflow for creating various
elements of vegetation, from
grasses and flowers to trees, using
3ds Max, V-Ray and GrowFX. We'll
also utilise some traditional poly-
modelling techniques to create
lily pads, and take advantage

of some handy tools in Forest
Pack Pro to scatter our newly
made models around the scenes.
Covering a range of plant species
should expose some of the wide

array of features GrowFX offers,
and provide a solid foundation to
continue exploring the plug-in and
create highly detailed foliage for
your scenes.

To help with the understanding
of the parametric modelling
process |'ve included captioned
videos to show the workflow, with
added visual reference to the
effects of each parameter. I've also
included both the GrowFX files
and collapsed meshes of all of the
planting covered.

For all the assets you need go to
creativeblog.com/vault/3dw205
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Vegetation for arch-viz

LILYPADS

POLY-MODELLING
TECHNIQUES

ONE START WITH A BOX

Model from reference as a guide.

A good poly-modelling method

to keep clean quad geometry

is to start from a box, apply a
TurboSmooth and Spherify modifier.

TWO VIEW ALIGN

Select the top half polygons in
top view and hit View Align in
the Edit Poly menu. Delete the
bottom half and we have a quad
mesh to work with.

THREE PUSH AND PULL VERTICES

Now go with the flow, following
the reference guide behind.
When happy with the shape,
apply Shell and TurboSmooth for
thickness and a Noise modifier
for more detail.

INTUITIVE MODELLING
Graphs are a useful
feature in GrowFX
enabling more control
over how the parameters
should behave

o CLICK TO PLAY VIDEO
www.bit Ly/1xx-xxxxx

2 START THE TREE TRUNK

It's time to add a distributor. Click the Standard
Primitives dropdown on the Create tab and click
exlevel GrowFX. Click and drag on the viewport to
create the GrowFX gizmo. Under Main Parameters
in GrowFX click Create Path. Now we can click
Distributors>Create Distributor in the window

that opens. For a tree trunk we need the standard
distributor at the top of the list. We should now have
a line indicating our tree trunk in the viewport.

4 ADD A BRANCHES PATH
Back in the GrowFX tab, click Create Path to add

another path to the model. Name this ‘branches.’
It's important to keep naming these layers to keep

» the process clear. In the Distributors menu go to

Create Path>Path Distributor and pick the trunk
as a starting path for the branches. Under Range
Parameters set Start to 18 per cent to instruct the
branches to start going 18 per cent of the way up
the trunk. Set Density to 24.

1 GATHER REFERENCES

When modelling foliage of any kind, | find it
extremely valuable to gather as much reference as

| can of each species | wish to create. It's important
to analyse the form and detail, and break down
how the plant works. Doing this will inform the
modelling process and help to identify the steps in
GrowFX that you may take, rather than approaching
it blindly. This ensures it is a close representation

of the real thing.

3 MODIFY THE TRUNK

For a tree trunk, parameters in the Distributor
window can be kept as default — this will come into
use later for other elements. Back in the GrowFX
tab, click Direction Modifiers then reduce Length
to 1000cm and Steps to 40cm. On the Modifier list
below, click the Create Modifer button and pick
Noise Direction to add some subtle variation to the
path’s direction. Reduce the Noise Scale to 750cm,
keeping the rest as default values.

5 USING GRAPH FUNCTIONS

Click the button for Path Position then select
Create Affect in the window that opens. Go to
Branches>Length and click the Graph button next
to Factor. Select the left-hand point of the graph
and give it a value of 1.3, and the right-hand point
decreasing to -0.225. Hit Choose Curve Preset
and give it a curve like the screenshot to ease

the effect in. This graph tells the branches to get
shorter towards the top of the tree.
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6 APPLY MODIFIERS

It's now time to modify the direction of the branches.
Set the Length to 280cm and Steps to 20cm. After
this, add a Random Direction modifier with
Smoothing set to 100cm and a Max Angle of 10. In
addition to this, some force direction with a Vector
Direction modifier will add some more realism. Add
a graph to the force parameter, with a straight line
decreasing from a value of 80 to 36.2

8 APPLY SHAPE WITH TWIGS

This layer is where the fullness of the tree will start
to appear. On the 'twigs’ path add a path distributor
with branches as a starting path. Within the
Distributor menu, set the Parameter Level to two to

create layers of twigs increasing the reach and shape.

Apply a density graph, straight lined and starting
with a value of one, increasing to 15. Additional to
this set Angle Bend to 52 and Chaos Angle to 10.

Set Path Length to 147cm.

10 HEIGHT INFLUENCED LENGTH

As we did for the branches, the same graph
instructing the twigs to get shorter the further along
the length, needs to be applied. Within Path Position
go to Create Affect>Length. Create another straight
factor graph decreasing from 1 to 0.74

7 ADD DEVIATION MODIFIERS

Deviation modifiers instruct the path to deviate/
change direction once joined up with another path,
for example twigs. This will add more realism to the
model. Firstly in the main GrowFX tab add a new path
named Twigs as we did for the trunk and branches.
Then click on the Branches layer, go to Deviation
modifier and add "twigs'. Uncheck Child Vector and
set Tolerance to 50cm. For angle create a straight
lined graph starting at a value of 10, increasing to 40.

9 APPLY GROWTH PARAMETERS

With some more tweaks the form will start to take
shape. Still in the Distributor, click the bar graph
affects symbol and create an affect for TWIGS>
Length, as done previously. Set the Affect factor
Graph to start at a value of 1, with a straight line
decreasing to 0.48. In addition, create a new affect
for TWIGS>PathDist>Density, with another factor
graph increasing in a straight manner from 1 to 25.

11 DIRECTION MODIFIERS

Adding Direction modifiers are a necessary step to
increase variation and realism for organic growth.
Set the Path Length to 147cm with a Steps Value of 4.
Add a random direction with a Smoothing Value of
5cm, and a Vector Direction modifier with a Strength
of 206. The tree is starting to get the desired look.
We'll need to add another layer of shorter twigs

by adding a new "twigs02’ path, back in the main

GrowFX tab.
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INVISIBLE EFFECT
Once the twig density is
increased the effect of
the Deviation modifier
will become visible

SCATTERING
MODELLED GEOMETRY

Forest Pack is a great tool for
scattering geometry efficiently,
with an array of density maps

and transformation parameters
which make it really easy to get a
random look. Perfect for nature!
If you need more control over the
placement of your models there is
also a useful paint function. Under
the Areas tab, click the paint
brush to add a new paint area.
From here you can tweak brush
size and whether you want the
area you paint to be an include or
exclude area for your geometry; in
this instance | used include. From
here you can paint directly onto
your mesh in the desired area and
watch your scattered geometry
appear with each brush stroke.
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Another useful
feature is the
ability to copy and
paste a graph

Make a decision early on.
This model is detailed for

closer cameras, but if your
model is only viewable

at a distance, you can
construct your model

to be much lighter.

12 COPY AND PASTE

Another useful feature is the ability to copy and
paste a graph. This is needed to copy and paste the
Affect graphs from steps 9 & 10 for levels and path
position, which quickens the process. After doing
this, pick twigs as the starting path and again,

set the levels to 2. Create a density graph, with a
straight line rising from 0 to 60. Give a Count Value
of 3. Chaos Angle should be set to 15.

13 ADDING GRAVITY

These shorter, lightweight twigs will be starting to
adhere more to gravity and start to hang from the
stronger branches below. As before, we need to
add a Vector Direction modifier only, with a value
much lower of -800. Combine this with a length
of 28cm and a Steps Value of 2 and the model is
much closer to being finished. The meshing of
the tree can now begin, before finishing with the
addition of leaves.

14 START MESHING

It's time to go back through our tree layers and start
meshing the tree. Click the trunk layer and open the
Mesh Builder window. Go to Create Mesh and select
Metamesh. This is a higher poly option to cylinder
but is vastly more realistic for junctions between
paths. Create a graph for mesh radius and create

a bezier decreasing from a value of 20 to 0. In the
GrowFX tab, go to viewport display and select mesh
instead of lines.

15 TRUNK MESHING CONT.

The trunk currently appears faceted. To solve this
issue, increase the minimum sides to 16 to give the
mesh a smoother surface. There are also options
to give the mesh ends a flat or rounded shape.

For the ‘end’ give the mesh a rounded shape. And
finally set the material ID to 1, which will come

into use when texturing using a multi-sub object
material. We now need to repeat meshing for the
remainder of the tree.

16 MESH THE BRANCHES

Now repeat the actions of step 15 for the branches
layer. Metamesh, but only this time set the radius
graph to a value of 14, with a smooth bezier
decreasing to 0 and a minimum radius of 0.2cm.
Again, this mesh will need smoothing so increase
minimum sides to 14 and again give a Mat ID of 1,
which will be the bark once we start texturing.
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17 USING CYLINDER MESH 18 ADD PATHS FOR LEAVES

For both twig layers of the tree, meta mesh will not Add a Path Position distributor and pick all paths as

be necessary. Selecting cylinder mesh will suffice starting paths. Click Add Position. Give the Count
due to the decreasing radius and visibility of these Parameter a value of 3, set type to Angular and set
elements, this will ensure the model isn't too poly Angle Divergence to 140 and a Chaos Angle of 20. In
heavy, without sacrificing realism. For the ‘twigs’ the Direction Modifier menu set Length to 10cm and
layer set a radius graph of 3 decreasing to O with a Chaos to 20. Add a Vector Direction modifier and set

minimum radius of 0.2cm. Copy and paste this graph  to -5000 to replicate gravity. Add a vector orient to
to "twigs 02’ with a slightly lower minimum radius of ~ ensure the leaves are face side up.
0.1 for thinner ends.

F

19 CREATE THE LEAVES

Select the Leaves mesh in the Mesh Builder menu.

It has a slightly higher poly than other options but
has more bend detail. The width parameter controls
the shape and size of the leaf. Open the graph,

this current graph line is increasing the width in the
middle before tapering off again at the end. We
won't need this as we’ll be using an opacity map for
the leaf shape, so set the graph to a straight line with
both values to 2.5 to create a rectangular shape.

20 SET MULTIPLE MATERIAL IDS

To give the leaves more colour variation when it
comes to the next step of texturing, set multiple
material IDs. Click the button next to the Mat ID
parameter called Parameters for Chaos Material

ID. Here you can add multiple ID’s and specify a
percentage of the leaves you would like this ID to
cover. Set three extra IDs for 2,3 and 4 and set each
percentage to 33.3%.
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OTHER MESH OPTIONS
Instanced geometry is
great for using pre-
modelled geometry, such
as flowers and berries and
Standard leaves offer a
variety of low poly shapes

CLIMBING
PLANTERS

GENERATING IVY
USING GROWEX

ONE USE POINT DISTRIBUTORS

This distributor lends itself well as
a starting point for ivy. You can
now create points and click in the
viewport where you would like
the ivy to start growing.

TWO0 OBJECT REACT MODIFIERS

Object react is very useful for
growing around Max geometry.
Make sure Magnetic is ticked, pick
the object and have a play with
strength parameters to get the
climbing ivy effect.

THREE USING OBJECT SLICE

Object Slice is another helpful
modifier when creating vegetation
that interacts with geometry. By
adding this you can pick objects
that would like GrowFX to not
grow through, avoiding messy
intersections between meshes.
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To activate Quick Mask
mode press [Alt]+[Shift]
and click the mask directly in
the layer stack. This creates
a 50 per cent translucent

red overlay that indicates
masked out areas.

CREATE GRASSES

The surface distributor has great
uses for modelling grasses, as
well as dandelion seeds and
more. Create a base surface from
which you would like GrowFX to
be distributed, in the instance of
grass a flat circular surface tends
to work out well. You can then
pick this object as a base and start
increasing the density of paths
and tweaking parameters. In this
grass example, this can be broken
down into three layers: the stems
sprouting from the surface, green
grass blades sprouting from the
stems as a path distributor, and
some low lying brown and dead
grass underneath. Once you have
created your model, if the base
geometry is not intended to be
visible this can always be put on
its own layer and hidden with the
GrowFX model unaffected.

21 SOURCING TEXTURES

A great and well used tool for decent textures

is www.cgtextures.com. Reasonably priced for
high resolution texture maps. It was particularly
useful in this project for its bark and leaf textures.
Shutterstock is another good website for sourcing
textures for your projects. You can download

the maps | have used for this model through the
download link.

23 GROWFX UVS

GrowFX geometry comes nicely unwrapped. The
bark texture may look out of scale when you apply it
so it might need some tweaking in the Mesh Builder
menu. Click the UVW Mapping button at the bottom
of the window and tick Absolute Width and Length.
Set both values to 200cm which should give the
mapping appropriate scaling to the model.

Once you've created your two-sided leaf material add
more variation and realism by creating another two
copies of the material in the multi-sub so it takes up
three slots: 2, 3 & 4. On the copies, go into the diffuse
slots of your materials, and add a colour correction
map. You can shift the hue, alter gamma and contrast
and give the leaves subtle variation when it comes to
rendering. Now test your model and materials in your
scenes to evaluate, tweak and render until happy. m

25 COLOUR CORRECTION MAPS

22 MASK LEAF

Bring the image into Photoshop, copy and paste

it onto a new layer and make a fill layer of block
colour behind. With the leaf layer selected, click
Add Mask. Choose a brush with a hard edge, make
its colour black. Now you can paint a mask around
the leaf, leaving the leaf area white in the clipping
mask and the background you don't need is black.
You can now create diffuse and alpha maps with
this selection.

24 TWO-SIDED MATERIAL

In the Material browser click Get Material and
create a two-sided material. In the front side slot
create a glossy leaf shader. The back material
needs to be a lighter coloured, less reflective
version for the back side of the leaf. Create a
black and white translucency map of just the leaf
stem and veins in Photoshop to dictate the two-
sided material’s translucency. Veins being less
translucent than the leaf.
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MASTER
PERSONALITY
IN YOUR 3D
ILLUSTRATIONS -

Hannah Kang reveals how to learn from
master artists to improve your 3D art

ARTIST PROFILE
Hannah Kang
Hannah is a graduate
of the Gnomon
School. She currently
works as a 3D artist
at Legacy Effects

in California.
hannah_kang.
artstation.com

TOPICS COVERED
Character design
Detail modelling
Composition
Rendering
Compositing
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efore starting o f
project, | like to b
and choose wisely

best ability) why | want to
modelling a certain subjec
drives me the most toward
direction for my project is tt
story aspect. Creating scen
and stories in my head mak
process much more enjoyak
instead of creating random
characters or scenes. | like feeling
connected to my work becaus
without that, | would be crea:
an empty, but pretty, image.
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TUTORIALS
Add personality to 3D art

What do you want your image

to look like? Is it more of an
illustrative piece or more of a
hyper-realistic scene? Depending
on what you want it to look like,
you may texture or render your
models differently. It's all

up to the artist! Knowing early on
what your end goal is, helps you
get there more smoothly.

TAKE A BREAK
Don’t keep sculpting
away. Step back,
evaluate, and make
critical moves. Have a
reason why you make
certain decisions

LEARN TO FOCUS

Being stuck in one area and not
being able to progress forward,
can really bring things to a halt.
For the boy, the expression was a
big challenge. With that situation,
getting tips from people you trust
— in this case my art director and
friend Scott Patton — to duplicate
the boy's face, forget the body,
and concentrate on trying
different expressions of the face.
Focus on the area you are having
trouble with.

o CLICKTO PLAY VIDEO
www.bit.ly/205-kang-1

1 FIND THE CHARACTER'S FACE

One of the first steps was understanding the
anatomy of the face; why certain features make the
face look a certain age. The age | was aiming for was
around the age of seven to 10. By sculpting from an
actual face and taking it back down to the level of
realism you want, was a way to understand what | was
hoping to achieve. At a very early stage of a project,
is the time to explore and figure out what you want.

o CLICKTO PLAY VIDEO
www.bit.y/205-kang-6
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o CLICK TO PLAY VIDEO
wwwbit.ly/205-kang-2

2 BLOCKING OUT

When | block out my characters, | mainly use either
ZSpheres or DynaMesh in ZBrush. At a very early
stage, it was hard to make the characters turn out
the way | wanted them to. When blocking out my
characters, | go through a creepy stage, where all my
characters don't look like they're all the way there yet.
The moment | added the smile to the face, it made
the boy look strange. | had to figure out how to make
his face look less creepy and make it look appealing.

CLICKTO PLAY VIDEO
www.bit.ly/205-kang-3

CLICKTO PLAY VIDEO
www.bit.y/205-kang-4

CLICKTO PLAY VIDEO
www.bit.ly/205-kang-5

3

A lot of figuring things out is trial and error. You
won't know what works unless you try it out! The
beginning doesn’t have to be perfect. | like to have
all my models blocked in the scene. Get everything
you need in there then afterwards all you are doing
is playing around with proportions, composition
and sculpting away. Capture the essence and the
feeling of the characters and see the potential of
where you can take them next.

CLICKTO PLAY VIDEO
www.bit.ly/205-kang-7

4 MOVING FORWARD

It's good to step back and see where your overall
project is heading. Stepping back and taking a little
break from your work helps you see some mistakes
you may have missed. For example, with the pants
on the boy, | sculpted them folded over to see if that
style of pants was going to work. But after stepping
back and taking a look at it, it was breaking the

line of action. Something minimal can make a big
difference in the overall picture.
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o CLICKTO PLAY VIDEO
www.bit.ly/205-kang-8

5 GRADUALLY ADD DETAILS

As the project starts to tighten up, | begin finalising
the details more. | don't get too fancy with the
brushes. | mainly use the Clay Build Up, Standard
Brush, and Dam_Standard. Using different alphas
helps achieve a variety of stylisation within the
brush. During your process, if you're not happy with
something that isn't turning out quite the way you
want it to, leave it and come back to it.

6 DETAIL, COLOUR & TEXTURE

I've decided to do all my texturing in ZBrush. | knew
early on that | like being able to sculpt and texture
as | go. Both goes hand in hand. When texturing,
many times you can hide mistakes that weren’t the
focus of this exercise. Hence being able to sculpt
and texture at the same time is a process that |

very much enjoy. Always keep in mind what your
end goal is.

7 FLOW AND RHYTHM

Adding movement to your models, helps sell the
image. The standard T-pose model doesn't cut it
anymore. When adding movement, think about
which way the direction of physics is happening.
For example, if the direction is going at a diagonal,
follow the diagonal movement — almost parallel to
it. Of course there are exceptions, not everything is
going to be 100 per cent parallel.

8 WIND BACK DETAILS

You want to be consistent with how much
information you give with all the models. On the
scale of realism, one being cartoony and 10 being
realistic, it is better to have everything four or six
rather than having two and 10. The teddy bear here
may have been approaching a seven. | needed to
make sure | pulled back so that it is in the same
world with the rest of the models.

9 TAKING IT INTO KEYSHOT

KeyShot Bridge is such a great tool to use in your
pipeline. It makes the process much easier and
saves you so much time by not having to do UVs,
export and import .obj files. What | suggest doing
early on, is taking it to your render engine and
checking how your model is looking under lighting.
You won't believe how different your model can
look from ZBrush to lighting your models.
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CLICKTO PLAY VIDEO
www.bit.y/205-kang-9

CLICKTO PLAY VIDEO
www.bit.y/205-kang-10

CLICKTO PLAY VIDEO
www.bit.ly/205-kang-11

CLICKTO PLAY VIDEO
www.bit.y/205-kang-12

EYE MOVEMENT
Avoid lines that cross
the flow. Composition
being important, you
want to be able to
move the viewer's
eyes around the
image easily

KeyShot Bridge is such
a great tool to use in
your pipeline. [t makes
the process much easier
and saves you so much time




TUTORIALS
Add personality to 3D art

Do test renders
‘and see what
your models are
really doing

4

COLOUR ADJUSTMENT

Punching the colours by adding
some blues to everything, helps
integrate the image and bring
everything together. | use soft
light for the layer blending mode,
then Levels to punch up the
colors. This is simple, but works!

THANKS ALL! P
Hannah would
like to thank
Travis Bourbeau
and Scott Patton
for all the help
with this project!

10 KEYSHOT CONTINUED

You are able to see what your models are lacking
and areas you need to push. Having the model

and textures at a good place, | come to a point
where | am tweaking my models, textures and
lighting all simultaneously. You come to a stage
where everything has to work harmoniously. Do test
renders and see what your models are really doing.
You will get the answers you need.

12 RENDER AND COMP

After getting to where you think is a good place to
composite in Photoshop, it's time to make render
passes. | don’t get too crazy with the render passes.

I render what | need. You don't have to be fancy or
complicate yourself to get a nice image. Make sure
your camera view is locked when you start rendering.
The main passes | create are a master render,
ambient occlusion and a mask.

e

7

"]

14 REFINE THE HAIR

For the hair, | cheat a bit by painting in the strands
myself. | get a Standard brush in Photoshop and
make the brush size very small. | use the Color Picker
on the base colour of the hair and | start painting
the strands. It's a back and forth process from from
highlights to shadows. To show certain areas of

the hair looking brighter, | change my brush mode
to Color Dodge. Always experiment and try using
different brush modes to discover new effects.

11 CONTROL YOUR LIGHTING

Being able to manipulate your own lighting is such

a huge benefit! Depending on how you light your
models can make a huge difference. You can create
the type of mood with just lighting. | add a plane
geometry in KeyShot and assign an area light to it. |
usually like having my main key light on top to mimic
sunlight, fill lights on the sides and back light for
some nice rim lighting. Play with the intensity and
colour of the lights.

£

13 ADD A BACKGROUND

| google a sky with clouds background. On the bottom
layer, | add the sky image and use Gaussian Blur to
create a foundation, then overlay another layer of
clouds. To add more noise, | use the Photoshop feature
(Filter>Render>Cloud). | use the Soft Light blending
mode and take the opacity down. Using layers subtly
to create one whole image makes for a better image.
On top of the cloud layer, | add another cloud layer and
Gaussian blur it slightly to blend, then | add a lens flare.

-

15 TWEAK IN PHOTOSHOP

In Photoshop, this is where you can make your
models look even better! | add a background and
use the Color Picker to add a blue hue over the
whole image, then put it on Soft Light blending
mode so the colours all match. This is a good time to
add noise, filters and variations to your image, but for
now | was able to pick up some great compositional
tools from one my favourite illustrators. m
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HOW TO EASILY CREATE
REALISTIC TREES

Wybren van Keulen shows how to grow true-to-nature
trees with Blender’s new plug-in, The Grove

ARTIST PROFILE
Wybren van
Keulen

Wybren creates visuals
for designers and
architects. Blender is
his trusty companion
and coding tools for
CGis his ultimate
creative endeavour.
www.thegrove3d.com

TOPICS COVERED
Tree growth

Bend

Environment objects
Branches

Twigs

The Grove enables you to

grow trees. It sounds simple
enough —and itis. The new plug-
in for Blender creates trees by
simulating their growth. It speeds
up their year-by-year development;
first growing new twigs, then
bending branches under the
added weight, and before growing
another year, pruning shaded and
weak branches.

The Grove is a simulation-based
algorithm that evolves true-to-
nature trees, with good results at
every year of a tree’s life — from
sapling to hero trees. However,
best of all is that it's easy, fast and
incredibly fun to play with.

In this tutorial I'll show you how
to get started with The Grove.
We'll begin by picking a preset,
repeatedly clicking the Simulate
button, and watching nature take

I nstead of modelling trees,

its course. You'll witness branches
grow, branches bend, and
branches disappear by pruning -
all done for you automatically. A
tree's shape depends on its DNA,
the hormones that flow through
its branches, and last but not

You can also take control by
tweaking the many parameters to
get the character you're after in
your own tree.

In this tutorial | am going to
give examples on how to grow
trees in every shape that you

The Grove is a simulation-based algorithm that
evolves true-to-nature trees, with good
results at every year of a tree's life

least, how it looks depends on
its environment. These three
things give you control in a very
natural way.

The simulation-based
approach of The Grove means
that it evolves natural trees,
year after year, in order to achieve
unrivalled results.

3D WORLD March 2016 . www.youtube.com/3dworld

can imagine. You are going
to learn how to set up an
environment to attract,
deflect or stop new growth;
avoid buildings, simulate a
dominant wind direction and
create topiaries.
For all the assets you need go to
creativeblogq.com/vault/3dw205



1 CREATE A BASIC GROVE

Here we're going to create beautiful combined
crown shapes when we grow several trees together.
Place and rotate one or more Empty objects to tell
The Grove where to start growing trees. Next, select
your Empty objects and go to Add>Mesh>The
Grove, and start growing. The trees interact with
each other and the space they exist in. As they grow
they prune each other and with age they will form a
natural group similar to those you see in nature.

2 FLOW AND GROW

The crown shape a tree evolves into is also dependent
on hormones flowing through the branching structure.
Favour main over side branches with Favor Current.
Boost crown growth over lower branches with Favor
Crown. Negative values create heavy side branches
and a less apparent main trunk. The Branching Loss
parameter controls the inefficiency of a branching point
—reducing growth power for each successive branching
generation —to fill the crown in a shrub-like fashion.

3 CONTROLLING THE BEND

Branch Weight controls the bending of branches under
their own weight, and this can be used in order to
create weeping trees. Bending at each node increases
with the amount of nodes it carries and decreases with
branch thickness and branch verticality. As branches
grow in width, they strengthen and limit bending.

You can also affect the bend of a tree by altering the
Leaf Weight controls; heavy leaves cause thin twigs to
droop, while strong twigs tend to bend up to the sky.

5 BUILD BRANCHES

After simulation, create a curves or mesh model of
the branches. Start with a Tip Thickness matching
with the twig's thickness, for a smooth transition. Then
add character to the branches using the Branching
Thickness Exponent. The trunk will seamlessly
disappear into the crown. Use the polygon reduction
tools for a lightweight mesh.

4 CREATE TOPIARIES

Use an environment object to attract, deflect or block
new growth. An environment object will affect tree
growth by blocking growth, attracting growth or
deflecting growth. Use combinations of these effects
to make your tree avoid a building, grow towards a
light source, or grow within a topiary shape. Use the
preset Topiary as a starting point, then experiment
and get creative.

6 DISTRIBUTE TWIGS

Twigs take over the last growth state by distributing
linked copies of modelled twigs, duplicated along
branches and placed in orientation to the sky.
Using a small, modelled twig model will save huge
amounts of memory and means you can also model
fruit and so forth. Twigs are placed and rotated
automatically so long as you make sure your leaf

or twig object points to the right when in top view.
Press [Ctrl]+[A] to apply size and rotation. m
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EXPERT TIP

Shade avoidance

ENVIRONMENT OBJECTS
Create dramatic tree growth

Type the name of the object to
interact with into the Environment
text field. A simple mesh object
with just several polygons can
have a striking effect, or use the
stylised shape of a building to
avoid it. Use complex shapes to
create a topiary. With the object
selected, its name appears in the
lower left of the 3D viewport.

If The Grove can't find an
object by that name, you see a
warning below the Environment
field. The object has to be on a
visible layer for interaction to
work. The attract and deflect
interaction types have a radius of
influence. When a branch grows
within this proximity, it gets
influenced by the environment.
The closer it gets, the more
powerful this effect becomes.
The Force parameter multiplies
this influence. Environments
are not static; surrounding trees
come and go, changing the tree’s
exposure to light and wind. Try
enabling interaction for just the
last years, in order to simulate a
windswept tree.
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ARVELOUS DESIGNER 5

CREATE A DYNAMIC

RENAISSANCE DRESS

Camille Kleinman shares her process for creating a
realistic dress in Marvelous Designer 5

ARTIST PROFILE
Camille
Kleinman

Camille enjoys drawing
and sculpting, and
teaching others the

art of digital clothes
design. She is an
expert in Marvelous
Designer and has a
video training program
for those wanting to
master the tool.
www.CGElves.com

create a beautiful, dynamic 3D

dress using Marvelous Designer
5 (MD?5) — the cloth simulation
software used by leading artists
and studios to quickly create
clothes for 3D models.

Used on games like Assassin's
Creed and Metal Gear Solid V,
as well as major motion pictures
including The Hobbit, Ted and the
Adventures of Tin Tin, MD5 is fast
becoming the industry standard.

Since the cloth is dynamic,
whenever you change your 3D
model’s pose, the clothes adjust
themselves accordingly and hang
realistically. You can even animate
the cloth and add wind to make

I n this tutorial you'll learn how to

it billow. MD5 cuts down on the
time it takes to create clothes.
Without it, you'd need to spend
hours sculpting each fold and
wrinkle in the 3D cloth. Then,
if you needed to change your
model’s pose, you'd have to re-
sculpt the wrinkles all over again.
Aside from the time it takes to
sculpt clothing, one has to spend
even more time studying cloth
anatomy and invest a lot of time
practising in order to be able to
sculpt clothes that look realistic.
MDS5 uses a pattern-based
approach to making 3D garments,
similar to tailoring in the real
world. To design clothes in MD,
you need to create each piece

of the puzzle, which are your
patterns, and sew them together.

Thankfully you neither need
to become seamstress nor get
your fingers pricked by needles,
but you will need to learn the art
of digital clothes making. Let me
show you how easy it is!

To make the most of all of MD's
features, you'll need to learn the
program properly. However, we
can't cover every function and
button of MD here, so | strongly
recommend that you get my
Marvelous Online Video Training
Program from the CG Elves site:
www.CGElves.com/LearnMD.

For all the assets you need go to
creativeblogq.com/vault/3dw205

o - CLICKTO PLAYVIDEO
- wwwbit.ly/205-dress-1 |

1 KNOW THE SOFTWARE

The 2D Pattern Window is where you create and
modify patterns. The 3D Garment Window is for
seeing what your clothes look like when you simulate
them. In the Object Browser pane you'll find the

2 CREATE THE BODICE

Most clothes are made from many pattern pieces. To
start, I'll create the patterns for the bodice. The best
way to keep both sides of your bodice symmetrical

TOPICS COVERED to one another, is by first creating half a bodice and

Patterns Scene tab, the Fabric tab, the Arrangement Points then creating a copy from it for the other side. So, to
Sewing tools tab, Bounding Volumes tab and the Measure tab. The  create the bodice patterns, we'll begin by using the
Simulation Property Editor is where you can change settings for Rectangular pattern tool, to draw out a rectangle
Posing fabric Physical Properties, fabric thickness, Particle somewhat wider than our avatar and about the
Animation Distance, sewing line type, and so forth. length we want the bodice to be.
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g0 to www.CGELves.com/LearnMD
and use this coupon code:
Jdworld-special

WINDOWS DRESSING

To create this dynamic 3D dress,
you'll need to install Marvelous
Designer 5. If you have a Mac,
Camille strongly suggests using
Bootcamp with Windows. From
her experience, MD5 functions
faster and better that way




TUTORIALS
Create realistic clothing

To accurately place a
Segment Point at an exact
length where you want it to

be, right-click on the Segment
Line. A pop-up box will open.
Select the first option Split
Into Two Lines, and type in a
length value where you

want the Segment Point

to be placed.

SEWING POINTS

See my arrows — they
indicate which Segment
Lines need to get sewn
to each other

KNOW YOUR FABRICS

MD fabrics are just like real world
fabrics and have inner and outer
sides. The inner side is always
darker than the outer side of the
fabric. For best results, you always
want to have the inner side in
and the outer side out. When
arranging the patterns behind
your avatar with the gizmo,
(unless you use arrangement
points) the fabric's inner side is
going to be on the outside, so you
will need to flip them horizontally
to bring the outer side out, where
it belongs!

3 USING SEGMENT POINTS

Using the Split Line tool add two Segment Points.
Let's add one Segment Point at 50mm from the

top left corner (this will be for creating the shoulder
strap), and the other Segment Point we'll place at
around 170mm from the top left corner (this is for
making an arm hole). Using the Edit Pattern tool,
let's lift up the bottom left Segment Point to create a
pointed front design for the bodice, as well as lower
the top right point to create an open cut shirt.

5 SEWING THE PATTERN PIECES TOGETHER

Use the Segment Sewing tool to sew the pattern
pieces together. After you've sewn the pattern
pieces together, rotate around your avatar in the 3D
Garment window to make sure that all of the seam
lines are running straight and aren't crossed over.

If you see any seams that are crossed over like an

X, you'll need to select your Edit Sewing Tool and
right-click on that seam in the 2D pattern window
and select 'Reverse Sewing’ to fix it.

6 REFINING THE BODICE

With the simulation you'll be able to see how the
garment hangs on your model. If you find the bodice
is too tight or too loose, you can easily change this
by modifying the bodice pattern. | want this bodice
to be snug and to look smooth without too many
wrinkles. So first | drag the bottom Segment Points
inwards to make it tighter around her waist. Then

| use the Edit Curve Point tool to curve the bodice
further inwards, in the places where it's too loose.

4 MAKE IT SYMMETRICAL

Use the Curve Tool to create the openings for the
neck and the arm holes. To make sure both sides of
our bodice are symmetrical, copy the pattern piece
[Ctrl]+[C], then right-click on the 2D pattern window
and select Symmetric Paste from the pop-up menu.
Select both pattern pieces and copy and paste
them to create the back of the bodice. Using the
World Coordinate Gizmo in the 3D garment window,
arrange the pattern pieces around the avatar.

N

If the seams look okay to you, press the space bar
on your keyboard to begin the cloth simulation or
click the big arrow on the top left of the 3D garment
window. If the seams are messed up and you didn't
notice it before simulating, you can always stop

the simulation (by pressing the space bar again),
undo the action [Ctrl]+[Z] and fix the seams before
simulating again.

o CLICKTO PLAY VIDEO
www.bit.ly/205-dress-2

7 CREATE THE WAISTBAND

This waistband will be concealed beneath the
bodice so it doesn't matter what colour you chose
for it. In order to know how wide to create the
waistband, measure the avatar’'s waist with the Basic
Circumference Measurement Tool. Select this tool,
click once on her bellybutton and then click once
more on another spot on her belly and drag the
mouse around until you get a circle around her waist,
indicating the distance in millimetres (mm).
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9 CREATE THE SKIRT

Start by making a long rectangle with the top slightly
wider than half the waistband’s width. Now copy

the rectangle and Symmetric Paste it. Click the left
Segment Point on the bottom left corner of one
rectangle and hold down Shift while clicking on the
bottom left corner of the other rectangle. While
holding down Shift key, pull the Segment Points out
to the left, making both skirts wider on both sides at
the same time, with the exact same proportions.

11 CREATING THE DECORATIVE WAISTBAND

Now that we've made the bodice, waistband and
skirt, let's add a decorative waistband over the skirt.
Start by adding another fabric in the Fabric pane by
clicking on the '+ Add’ button. Load in the seamless
trim texture to use for the waistband. Next,

count and sum up the four lengths of the bottom
Segment Lines of the bodice and create a rectangle
of that width. To create the pointed design in the
front, grab hold of the bottom Segment Point on

r—ee w
8 TIGHTEN THE WAISTBAND

Now we know how wide to make the waistband,
take the Rectangular Pattern tool, click once in the
2D pattern window and type in the appropriate
width and height. To make the waistband close
around the avatar, segment-sew both ends
together. Next, we want to wrap the waist band
around the avatar's waist. To do this, use the
shortcut [Shift]+[F] to bring up her Arrangement
Points and click on her belly point.

10 SEW AND SIMULATE

Using the Gizmo in the 3D Garment window, position
one skirt in front of the avatar and one skirt behind
her. Using the Segment Sew tool, click once on the
bottom line of the waistband. Then, holding down
the Shift key, click once on the top Segment Line of
the front skirt and then on the top Segment Line of
the back skirt. After letting go of the Shift key, you'll
see that Marvelous Designer has sewn both skirts

evenly to the waistband.
the left and drag it out, then right-click and type

=

in an exact length. Repeat the same thing on the
other side and then sew the two edges together.
To attach the waistband, use the Segment Sew
tool. Click once on the top Segment Line of the
waistband and then, while holding Shift, click on
the bottom Segment Lines of the bodice, in the
right order, to correctly attach the waistband to
the bodice.

% S
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If you want to have more
wrinkles/gathers on the waist
area, then you'll need to make
the top part of the skirt wider.
To have more folds and more

fabric overall, you'll need to
make the entire skirt wider. If
you want the skirt to have more
fabric without more gathers
and wrinkles on the waist,
simply make the bottom

part of the skirt wider.

FLIP THE PATTERN
Prior to simulating,

be sure to give the
back skirt pattern a
horizontal flip to reveal
the outer side

WHAT IS PARTICLE
DISTANCE?

Particle Distance (PD) makes the
mesh denser. In MD5, with low
PD values, the clothes will have
finer detail but the simulation
will take longer. Not all patterns
require the same PD; some things
like waist bands or tight shirts
without too many wrinkles can
easily be set to a higher PD, while
parts that have a lot of wrinkles
and gathers need a lower PD to
capture all the detail. To change
the Particle Distance, select your
patterns, either all at once by
hitting [Ctrl]+[Al, or by clicking
on the individual patterns.




SHORTCUTS

Speed up your y

When working in MD5, you'll find
that using shortcuts (hotkeys) will
save you lots of time. If you don't
like using keyboard shortcuts,
you could do this instead: before
turning the Segment Point into

a Curve Point, position the
pattern over the grid so that the
Segment Point sits on a vertical
line. Use that as the centre line
reference. Using the Free Sewing
tool, sew half of the sleeve onto
the front armhole and half onto
the matching back armhole.
Next, we'll make the sleeve a
touch shorter and a bit tighter
by bringing in the two bottom
Segment Points from either side.
Note: make sure that both side
Segment Lines of the sleeve are
always the same length! If one
side is longer than the other, you
will get a bunching up problem.

12

Sometimes a seam gets twisted, so make sure to
check your seams before simulating. You can hide
your avatar and if you see any seams that are going
through the dress or look messed up, simply use

the Edit Sewing tool in the 2D Pattern window, right
click on the seam and select ‘Reverse Sewing'. If the
decorative trim texture does not fit perfectly onto
your waistband pattern you can always stretch it or
scale it up or down using the Texture Transform tool.

“—:aﬂlm_ﬁ
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The Segment Point now sits in the centre of the
rectangle. Since we cannot position a Curve Point
in the centre of the pattern, | use the following
workaround to first place a Segment Point in the
middle and then turn this into a Curve Point. While
holding down Shift key, use the Edit Pattern tool
to lift up the Segment Point. This creates a pattern
with a pointed top.

1139 66 1139 €
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To create the upper sleeve, start by summing up the
lengths of one (curved) arm hole Segment Line in
the front and one in the back. Click anywhere in the
2D Pattern Window with the Rectangular Pattern tool
and type in an approximate length in the pop-up
box. Next, to find the centre of your rectangle, use
the Split Line tool and right-click on the top Segment
Line to get the pop-up menu, then type in 50 per
cent in the Ratio box.

i Delete Point

Convert to Curve Point

15

Next, using the Edit Pattern tool, right-click on the
Segment Point and select ‘Convert to Curve Point'.
To sew the sleeve, click on the pattern with your
Transform Pattern tool to find the centre line (you'll
see a thin grey line indicating where the centre is).
Hover over that centre line and, using whatever
keyboard shortcut key you've assigned to it, switch
over to the Free Sewing tool.

136052
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Start out by making a rectangle, then add a Segment
Point in the centre of the bottom Segment Line

and delete the two Segment Points on either side
(pictured with red Xs) to get a triangle. To create
gathers and wrinkles, make the draping sleeves
wider than the upper sleeves. Use the Edit Curve
Point tool to curve out the sides of the sleeves.
Finally, sew the top Segment Line to the bottom
Segment Line of the previously created sleeve.



17 DETAIL AND REFINE THE MESH

To close off the neckline, | choose to run a thin
piping line around it. You can assign any colour,
texture and material to the piping line and make

it any width between Tmm and 15mm. You can
decorate the sleeves by overlaying a seamless trim.
To overlay an image over your clothes: [1] Click the
2D Graphic Tool (P icon) and load in your trim. [2] To
make the seamless trim repeat all along the bottom
of your sleeve, use the Pattern Transform tool to

18 POSE THE CLOTHES

There are several ways to pose an avatar in MD5.
One way is to use X-Ray joints to move the avatar’s
body parts. X-Ray joints are great for interactively
moving arms and legs while creating the clothes,

to see how the clothes hang in different poses.
However, using the X-Ray joints method for creating
a pose can be quite challenging and often creates
distorted limbs, stretched-out body parts and
unrealistic poses.

20 ANIMATE THE CLOTHES

Aside from simulating your clothes on a pose,
MDS5 also enables you to record cloth animations.
Simply import your animated model and click
the Record button in the Animation Tab to
record a cloth animation. Here are the formats
MD?5 supports for importing animated models/
animation data: FBX, Collada, Maya Cache, Point
Cache 2, MDD Cache (Standard), MDD Cache
(Maya/3DS Max).

stretch the texture. This creates a very distorted
looking stretched-out texture. To fix it, use the
Texture Transform tool to stretch the texture back
into shape (this only works with tiling textures like
trims or stitches). You can also go into the Property
Editor to change the colours of the decorative trims
as well as their specular colour, opacity, and so forth.
[3] Finally, in order to get the most amount of detail
into our clothes and smooth out the rough lumpy
look, we need to lower the Particle Distance (PD).

19 ALTERNATIVE POSING

If the X-Ray joints method isn't working, instead | like
to import a Collada file and save out the pose, then
later re-import the saved pose. You can import a
posed .obj model as a morph target. Or, if you have
a dramatic pose change, such as from a T-pose to
lying down, then the best way to pose your model
without running into issues with limbs going through
cloth, is to import an animated Collada file and
record a short animation.

21 EXPORTING THE CLOTHING

Before exporting your clothes, you'll want to make
sure you have the right mesh format. By default,
clothes made in MD5 have a tri mesh, however if
you need a quad mesh instead, you can simply
right-click on your clothing in the 3D Garment
window and select Quadrangulate. MD5 supports:
OBJ, FBX, LXO, OBJ Sequence, Maya Cache, Point
Cache 2, MDD Cache (Standard), MDD Cache
(Maya/3ds Max). m
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If you don't have a powerful
computer, you'll most likely
want to keep the Particle
Distance at a higher value when

bringing in a new pose and
draping your clothes on it.
Once your clothes have draped
the way you want them to

be, you can lower the

Particle Distance.

CG ELVES

| hope you enjoyed this tutorial.
If you want to know how to
quickly create all kinds of clothes

for your 3D models, check out my
Mastering Marvelous Designer
training program at www.
CGElves.com/LearnMD and
use the coupon 3DWorld-special
to save 50 per cent!
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Josh Parks

Josh is a compositor
at MPC as well as

a part-time lecturer
at the University

of Hertfordshire.
www.joshparks.co.uk

- PROJECTINSIGHT

An introduction

to V-Ray for Nuke

Josh Parks shares the pitfalls and solutions to getting started
with the latest tool in the compositor’s arsenal

-Ray for Nuke is an exciting
g / plug-in in the compositor’s
growing arsenal of gizmos
and plug-ins, which are available to
throw at a project, in order to make
quicker changes to the look of a shot.
As someone who has used V-Ray a
little while ago in Maya, I wasn’t sure
how I felt about the plug-in for Nuke.
Ilike the idea of bringing in all the
image sequences and starting from
there, with all decisions on textures
and lighting having been decided
previously in the pipeline. Despite
this, I can see a need for compositors
to have access to make these changes
in Nuke. When I started with the

plug-in, I didn’t realise I'd be using
both V-Ray specific nodes and
regular Nuke nodes in unison. As a
compositor, using this whole set of
new nodes is something I originally
thought would feel alien. But the
approach Chaos Group has taken
allows for the whole experience to
feel incredibly natural.

I was lucky enough to be able
to meet with Shahin Toosi, a VFX
artist with a lot of experience
using the plug-in. By using this
plug-in he’s shown the biggest VFX
companies just what is now possible
within Nuke, which I hope to be
able to do with you.

In this series of articles ’'m going

to cover how to get started with

the plug-in and go over some more
advanced uses of it, as well as discuss
how I've used it in my workflow. In
this tutorial I'm going to run you
through my initial questions when

I first installed V-Ray for Nuke and
cover the solutions step-by-step in
order for you to understand just how
you could use this tool in your
current workflow.

Thanks to Andrew Hodgson at
ILM for kindly letting me play with
his spaceship model!

For all the assets you need go to
creativebloq.com/vault/3dw205

The plug-in uses both V-Ray
specific nodes and regular
Nuke nodes in unison




PROCESS:

Solving the issues you may have when first using V-Ray for Nuke

Exit Color |9.875

¥ Lock Glossines

use fresnel

R Lock fresnel ior

ONE

When look developing your materials or adjusting your
camera, it's a useful idea to reduce your subdivisions.
This will give you quicker render times and allow you to
look develop as efficiently as possible. | was originally
using a NoOp node connected to the subdivison knob
in my Material and Light nodes, that I could then adjust.
However, there's a better way of doing this. ..

THREE

You can use a VRayProxy node in order to bring your
geometry into Nuke in a lighter state, that's quicker
to work with. This will stop the geometry being
cached until it's needed for rendering and makes the
geometry a lot lighter for Nuke to handle. You need
to use an alembic file for this. I'll cover exporting
alembic files in future tutorials.

uELAPplyMaterial2

FIVE

To do this underneath your read in geometry or
VRayProxy node hit tab and put an ApplyMaterial
node in. Bring up the properties of the node and next
to Filter change the drop-down from All to Name,
then the second drop-down to the side will appear.
This needs to be set to Contains, then in the box to
the right of this simply put in the number 2.
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Global

Depth of Field

ommaon

mult = findByType("SettingsDMCSam

print multf0

mult[0].set{"subdivs_mult", 0.5)
mult[0].set{"div_shade_subdivs”, 0.5

TWO

After meeting Shahin Toosi, he made me aware of using
a piece of Python that would adjust the subdivision

value in any node with a knob labelled subdivs_mult or
div_shade_subdivs. This allows you to half or quarter the
subdivisions quickly, or increase them for the final render.
The piece of script can be found in the Vault. Copy it into
the Python panel within the V-Ray Render node.

ApplyMaterial2

ApplyMatenal Node

display unchanged
render unchanged

fiter name *

selectabile

contans

FOUR

In order to apply materials to your object use an
ApplyMaterial node. Within this node you have the
option of applying the material to the whole geometry, or
to a certain group containing certain words. Something
I've found useful is to number pieces of geometry; this
way you can very quickly just put contains “2" and you'll
apply the material to this geometry.

SIX

As someone who comes from a compositing mindset,
| found the ability to quickly create my own mattes
incredibly useful. | wanted to use the plug-in to get
the look | wanted as quickly as possible, and although
I could have fiddled with shaders, being able to
precomp my V-Ray scene output and go in with Grade
nodes was awesome.

twitter.com/3DWorldMag

SCRIPT

from vray.utils import *

mult = findByType("SettingsDMCSampler”)
print mult[0]
mult[0].set("subdivs_mult”, 0.5)
mult[0].set("“div_shade_subdivs”, 0.5)
You can change 0.5 to any muliplier you
want at 0.5 sub division of 2 becomes 1

As someone who comes
from a compositing

mindset, | found the ability

to quickly create my own

mattes incredibly useful



DEVELOP

Project insight

You've now assigned

an 1D number to

‘whatever geometry

you've set in your

REMOVE CHANNELS

Speed up your workflow

Material ID
Multimatte ID 2

SEVEN

To set up your own mattes you need to first bring in a
VRayMtlWrapper and place it in between the VRayMtl
and the ApplyMaterial node. Untick all the additional
surface properties and matte properties. In the Material
ID section give your geometry an ID number. You've
now assigned an ID number to whatever geometry
you've set in your ApplyMaterial node.

NINE

Having a node-based 3D scene in Nuke means you
need to come up with a way to organise your scene.
I really like having a scene node for each part; one
for my lights to plug into, one for my geometry and
materials, and another for my VRayRenderElements
to plug into to set up my passes.

RaySamplerInfo
(Normal)

tex

ExtraTex1(Normal)

ELEVEN

Something I've found incredibly useful is the ability to
render out my own data passes to use later in my
composition. You can do this by bringing in a
VRayRenderElement and setting it to ExtraTex. This allows
you to turn antialiasing off, which you'll want to do with
data passes. Next, plug a VRaySamplerinfo node into it by
pressing Tab and typing VRaySamplerinfo.
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Render Element |[Multi Matte

Channel Name ‘Multi Matte

® Consider for An
Red object ID &
Green object ID @
Blue object ID @

® Use material 1D

EIGHT

To create a channel to keep this ID information, you need
a VRayRenderElement node. This allows you to render
out your own passes to give more control in manipulating
your output further down the comp. Bring this node in by
pressing Tab, typing VRayRenderElement and pressing
Enter. Change the Render Element to Multi Matte, plug
this straight into your scene node and you're done.

Read/Write
RayTexBitmap

TEN

The TextBitmap node allows you to read in a texture —a
little like a precomp, by doing your work on the texture,
grades and so forth. Then plugging the TextBitmap node
into the Write node. This allows it to read in the written
out image sequence without it being cached.

None
CamToWorld
RayDirection
Point

PointObject

PointCamera

TangentUCamera

TangentVCamera

TWELVE

Rendering your own data passes is a must. By going
into the VRaySamplerinfo node you can then access a
drop-down menu to select what data pass you want to
have it kick out. In the VRayRenderElement node you
can give it a channel to hold the information.

twitter.com/3DWorldMag



More human than human?

Dr lan Palmer considers how technology is helping
film robots become more human

Sign up for the
VFX Festival
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obots have been a
mainstay of films ever
since Maschinenmensch

in 1927’s Metropolis. This was
the start of robots that resembled
humans in film.

Since then, from GORT to
Johnny Five, robots were created
with inspired use of costumed
actors, makeup, animatronics and

puppets. Then came the liquid
metal T-1000, a robot that could
morph into your worst nightmare,
driving forward fluid simulation
and rendering. The fact that in

its raw form it was as reflective

as polished chrome just makes

it all the more impressive. This

signalled a shift in robot making,
in a quest to make them even more
realistic and suspend the disbelief
of the viewer.

Unreal gets real

The rise in CG and its uses has
given birth to more believable
mechanicals. Last year, we met
Ava in Ex Machina, which again
showed how CG could construct
a creature that made you ask
questions: “Where did the robot
start and the human end?” or
“Where did the CG begin and the
human end?”

Likewise, Chappie threw
audiences again as the animation
ran counter to the design; built
for combat, Chappie moves and
behaves accordingly but once
reprogrammed he adopts a child-
like innocence we immediately
empathised with.

Over the years, artists in the
industry have used all the

Dr Ian Palmer
lan develops and
teaches short courses
and degrees in games,
animation and VFX
at Escape Studios. He
has a doctorate in
. Computer Animation
and is a National
Teaching Fellow.
www.bit.ly/ijpalmer

available tools to create human-
like robots, but also ensured that
they retained elements of their
robotic traits. The processes
and technology that have been
developed have obviously
contributed to the increased
possibilities of creating robots
that look even more human, but
the best animators and VFX
artists also know when to draw
the line and where to emphasise
the mechanical elements, as to not
completely overshadow what we
hold dear in the first place.
Technology now enables us
to create a fully functioning CG
C3PO that wouldn’t reflect the
crew on its metallic surface, but
would we really change anything
else? I'd say not. VFX is all about
making what we see believable,
rather than simply making
something seem more human.
For more on VFX visit the VFX
Festival: www.thevfxfestival.com



Marta
Niemczynska
Marta is a 3D designer
at Corporation Pop in
Manchester. For many
years she produced
work for animations
and commercials and
is now focusing on
game engines.
corporationpop.co.uk

| rovEEmeE
Building a 3D virtual

studio in Unity

Marta Niemczynska explains the process for recreating her
design studio as a 3D virtual environment in Unity 5




e’ve been using Unity
for more than five
years, so when Unity

5 launched we wanted to test

its new features, particularly

the physically-based shader and

realtime GI (global illumination).
PBR (physically based

rendering) texturing is not a

new concept, but we hadn’t had

the chance to use it in the Unity

engine without using third party

assets. We decided to recreate

Corporation Pop’s studio as
closely as possible in Unity 5.
Here I share our insight from the
project, in which we create an
online 3D virtual environment.
We started by making detailed
plans of the studio using
MagicPlan, so these could be
transformed into 3D walls. It
creates vector plans that can
then be imported into Cinema
4D and extruded into walls.
Unfortunately we couldn’t use




Project insight

It's vital to have detailed floor plans. Our plans

were very basic, so we recreated them using mobile
app MagicPlan, which lets you draw plans by using

a phone camera. You walk around your building

and place corner points. After calibrating, the app
automatically measures the distances between the
points and creates vector plans which can be imported
into Cinema 4D, extruded into walls and adjusted.

PROCESS:

Recreating a real place for VR

What platform is this project for? How is it going to
be used? Could the assets be used in another project?
What tools can | use? What are the challenges? By
asking these questions it will help to solve possible
problems before they occur. Start gathering reference
material to make life easier. We took photos of every
corner of the studio, recorded films and made early
decisions on the props we would be making.

THREE

FOUR

We chose precomputed Realtime Gl to try Day/Night
lighting, which you can't achieve with baked GI. There
were issues with light leaks where the roof touches the
walls, but keeping full walls instead of planes, adjusting
lightmap settings and cranking up the lightmap
resolution solved most of them. Use your own lightmaps
instead of Unity-generated versions. Baked Gl appears

Once you have walls and a roof, add space for windows,
doors, support beams and flooring. Plan how to divide
it into manageable sections and how textures will work.
After considering a modular approach — common in
game design — we opted for a full extruded version split
into floors with detached roofs, floors and staircases,

as it would have multiple uses, including AR in an

isometric view.

There is nothing more satisfying than having a stroll

through a virtual environment you have created... | cant
see an end to the testing and retesting of every element

the app to draw the ceilings
and roofs, so this was achieved
by examining the building and
figuring out the shapes.

To create windows, doors,
staircases and the roof, we had
to understand how the geometry
of the building works, which
involved taking lots of reference
pictures. This raised some
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more stable and returns less artifacts.

interesting features. I'd never
realised that the supporting beams
1 see above my head everyday are
different sizes and extend through
to another room, reflecting the
shape of the roof. As you move
through the build you notice more
of this type of detail, which raises
more questions. It’s vital to fully
appreciate these elements of the
design and build to ensure realism.

Complex texturing
Textures are probably the most
important part in game engine
based environments. Limited
by the amount of polygons we

twitter.com/3DWorldMag

can use, we can’t use geometry
to create detail, so only good
texturing can fool the eye and
create detail where there is none.
Our build was for desktops,
however the simplified assets
would also be used for an AR
(augmented reality) version
of the studio and VR (virtual
reality) could be considered at
a later stage. Therefore, by
asking these questions early on
we realised that while geometry
should be fine across all of
those versions, texturing
would have to be adjusted for
each medium.



FIVE

Use tiled textures for large areas. We prepared brick,
wooden floor, stucco textures and roof slates in Substance
Designer, which makes creating complex textures easy
and allows control of each of the channels. Cinema 4D
and Unity have full support for Substances. We used
Cinema 4D to UV the building and assigned materials to
respective parts. Once imported to Unity we replaced
those materials with Substances and adjusted tiling.

SIX
With a lot of props to create, focus on the major
elements. Our Chesterfield couches were complex,
so we created a high and low poly model in Cinema
4D with materials assigned to low poly versions for
separate elements. We brought both into Substance
Painter, baked maps onto a low poly model and

WHO ARE
CORPORATION POP?

The agency combining creativity
and technological innovation

textured. Some props like phones were fully textured in
Cinema 4D, others use basic materials or substances.

SEVEN

Multiple light set-ups and testing are required for a realistic
effect. For areas with little natural light, we used point
lights and LED ceiling lights with emissive materials. Night
lighting consists of multiple spot and point lights at the
light sources. Unity's sample project ‘The Courtyard’ offers
insight to controlling the time of day cycle. Avoid too many
image effects as they can impact on performance. We used
antialiasing, bloom, vignette and colour correction scripts.

EIGHT

Seeing a scene in the first person perspective while
fully immersed, creates new challenges and requires a
different approach to the way we create virtual worlds.
Realism, PBR texturing, post effects and a frame rate
of 75 or more are challenging with no simple solution.
We've made simple test builds for our studio, such as
scale, lighting, texturing and colour intensity, and all
impact how you feel in the environment.

Substance Designer and Painter
allowed fast creation of complex
texturing that would work well
across various game engines.
Allegorithmic’s Substance
Designer was used for the brick
walls and wooden floor as it was
vital that they were realistic,
detailed and seamless.

Moving to Unity

You can’t comprehend how many
objects are in a room until you
have to model them. We focused
on recreating the most important
props. Some of them, like a tripod
lamp, were fairly simple to make

and texture since they consisted
of primitive shapes. Others, like
orange chesterfield sofas, took
longer as they were vital to the
final look and required much
more detail.

We created a high poly version
of one sofa and used it to bake
a detailed normal map, which
would then be used on a low poly
version. We textured the sofa in
Substance Painter. It has a layer
system, which helped deal with
the complex surface.

All of the texture channels
were easily exported for use in
Unity. After many tweaks to
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the materials, multiple light
setups and a very long and
frustrating journey of finding the
right lightmapping settings, the
result is a realistic series of
props that bring to life our 3D
virtual studio.

There is nothing more satisfying
than having a stroll through a
virtual environment you have
created. But as this is such a
personal project, I can’t see an
end to the testing and retesting of
every element. I feel that this will
be a continually evolving project.

For all the assets you need go to
creativebloq.com/vault/3dw205

twitter.com/3DWorldMag
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Cirstyn is a freelance
CG artist and
educator, with over 15
years' experience in
3D. Her clients have
ranged from AMD to
Daz 3D and Future
Plc. She is currently
providing design and
tutorial content to
HobbyRenderer.com's
launch in February.
nothem-studios.com

Poser P

Poser $199 Poser Pro $499

oser 11 comes with
P many new features and

tweaks, including Smooth
Translation of Joints, adaptive
rigging, area lights, volumetric
materials and caustics, subdivision
morph targets, metrics and an FBX
exporter. Of course, the standout
feature from this release is the new
PBR renderer, SuperFly.

Based on a forked version of
Blender’s Cycles, it brings Poser’s
rendered output on par with
Reality, the Lux-based PBR plug-in
for Poser, and Daz Studio’s iRay.

Alas, the SuperFly
implementation could have
benefited from a little less
reverence and a little more
functionality. This is because
Smith Micro - makers of all
things Poser - are very loyal to
Poser’s original, iconic, late 90s
MetaCreations interface and
workflow. This could be the reason
why the Advanced Material Room
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Smith Micro

has not been modified much to
facilitate Cycle’s many nodes

with features commonly found in
anode-based environment, like
grouping, zooming, and tidying
functionality. Instead, you
navigate via a horizontal and
vertical slider, no matter how many
nodes you have in the room.

In addition, the renderer is not
as fast as iRay and Reality, and
its settings can be confusing,
especially for many of the ready-
to-render novices Poser caters to.
Even though render speed will
always depend on CPU, GPU, the

ro 11

my.smithmicro.com/poser-3d-animation-software.html

amount of content in your scene,
and its various shaders, a CPU
SuperFly render of a glass, wine,
five lights and a backdrop should
not take over 12 hours to render on
super high settings with caustics.
One issue could be that once you
select CPU or GPU, and then select
a preset, your selected hardware
will jump back to your CPU. If
you’re not aware of this, you can
get into some very long render
times indeed.

Poor user guidance

As for the quality of the output,
once you get familiar with the
new renderer and its workflow
it is actually a relief to be able to
do good metal, volumetric and
caustic renders in Poser without
having to use Reality or Octane.
However, Smith Micro have not
been good at documenting how
to go about this, unlike freeware
Daz Studio, who added shaders,

twitter.com/3DWorldMag

SuperFly's slow, or
random rendering
speed, and other
issues, detract
from what could
have been a

great release



ONE OF THE OLDEST 3D APPLICATIONS AROUND

Created by Kai Krause's iconic MetaCreations in the 90s, Poser has, over the years,
been a consistent gateway drug into 3D for many, as its ready-to-render content
and easy interface has taught many beginners the X, Y and Z of 3D.

New, Blender
Cycles-based
renderer, SuperFly

Actor Selection
History

Smooth
Translation of
Joints

Can create handles
for ghost bones

Measurement and
Text Props

lights and ready-to-render scenes
to analyse for users new to iRay.
Instead, you get outdated links

to poser.com and two chapters in
the manual explaining the dialog
and the nodes, in addition to some
mentions here and there, and the
response, “Yes, there is a learning
curve” when people ask about
SuperFly in the Poser forums. To
quote a user in the RDNA forum:
“This is like explaining the plus
sign, and then expecting users to
do complex algebra.”

Features with potential
Despite the growing pains of a new
renderer, the other new features
fare better. For content creators,
the new ability to create handles
for dresses, cloaks and skirts is a
godsend, and Smooth Translation
of Joints actually does add more,
and better control to figure rigging.
Adaptive Rigging for Morph
Dependent Joint Centers does

3D WORLD

ease the tweaking of conforming
garments to fit figures morphed
from dwarf to orc-size easier.

In addition, you can now create
morph targets on subdivision
levels and export them. To boot,
real world-based Area Lights beef
up realism in renders, and Actor
Selection History functions, like
the Photoshop History brush, are
superhandy when you’re building
your scene and still working out
its look and figures. Together with
the configurable Autosave they do
help ease your workflow, like many
of the other features.

So, is it worth picking up?
Despite Poser starting to show its
age a little, and if you don’t mind
the learning curve for Cycles and
shaders in Poser 11, the other
new features are fairly decent for
hobbyists, content creators and
forensic artists alike.

March 2016

Poser 11 would've
benefited from a
little TLC in the
Material Room as
content converted
to SuperFly gets
messy, fast

twitter.com/3DWorldMag

IN PRACTICE:

I first ‘met’ Poser on a PC World
CD. I think it was version three.
I've used it on and off over the
years, especially when dipping
my toes into content brokering.
I really liked the thought of
Cycles in Poser; it was a good
choice, when Lux and iRay
were already taken. | wasn't

so big on the implementation,
though, and the fact that Poser
still hogs all your resources — to
the extent your system stutters,
hangs, or crashes. It was
actually less cumbersome for
me to render SuperFly via CPU
than GPU. | also experienced
hangs forcing reboots when
using high subdivision levels,
which is something I've never
experienced in Daz Studio, Max,
ZBrush or Mudbox. Hopefully,
these are new release issues and
will be patched.
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With Stick & Paint

imagery added
beneath shadow
and reflection
passes, the result
looks no different

than if it had been

fully rendered

O

Paint & Stick

$199/£131/€181 for Paint & Stick; $99/£65/€90 for Paint |

fter four years in
development, Paint & Stick
has arrived, and mighty

impressive it is too. Effectively
two plug-ins in one, it enables the
creation of hand-drawn animation

within After Effects, plus the ‘gluing’ ObJECt and have It Conform

of 2D elements on to 3D renders.

It features the usual array of
painting tools, with the import of
Photoshop brushes and creation of
custom brushes within After Effects,
onion-skinning, plus erase and
matte brushes (for erasing strokes
or the layer itself). For compositing
artists and animators, this in itself
is worth the investment, but as this
is 3D World we’re more interested
in the ‘Stick’ part than the ‘Paint’
part. With the sticky paint tools,
you’re able to attach a 2D element
to arendered 3D object and have it
conform to the shape as it moves.

First you need to generate an
Object ID pass and a Sticky Pass
of your 3D project - plug-ins are
provided for Cinema 4D and
Maya. Fortunately, it’s all neatly
automated and takes very little time,
as it’s merely rendering the objects’

YouTe able to attach a 2D
element to a rendered 3D

to the shape as it moves

coordinate mapping. Back in AE,
you load your footage, add a new
solid layer and apply Paint & Stick.
You then load the Object ID and
Sticky Pass sequences, and link
them to the plug-in so it can
identify each object and how it sits
in 3D space. It’s then a matter of
either loading in a premade brush
(currently limited to 500x500-pixel
PNGs) or capturing one from an
image or footage in the timeline,
with all of AE’s native tools at hand.
Choose arelevant frame - for
example where the subject is neatly
face-on - apply the brush and
then hit the Glue button. Now like
magic, when you scrub through the
timeline, the image will adhere to
the object, moving in concert and

PAINTING IN 3D

aescripts + aeplugins |

being occluded by itself and other
objects. Even on complex scenes the
results were excellent and looked
no different to a full render. In one
example, we output a blank bottle
and box and applied labels to them
in After Effects. By placing the Stick
& Paint layer beneath the reflection
and shadow passes, the imagery
was tied in perfectly to the scene.
But if you suddenly need to change
alogo, you simply hit the Delete All
Glue button, apply a different image
and re-render.

Aswell as adding logos, decals
and other imagery, Paint & Stick is
also ideal for last minute revisions,
enabling you to correct errant
textures or cover up unwanted
artefacts without the need to re-
render the entire project. It’s an
ingenious bridge between the worlds
of 3D and 2D, and while version
1.0 is easily deserving of a place in
your Effects menu, we think future
editions, with the ability to ‘glue’
animated sequences, will be absolute
must-haves.

Formerly known as 'Stickey Paint’, the plug-in was conceived by TD and 3D generalist Chris Vranos in 2011, and
first publicly shown in April 2014. The next step is to port it to other compositors and introduce the ability to glue
animated sequences, as well as paint reflections and highlights..
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www.aescripts.com

Painting/
animation toolset

right within Adobe
After Effects

Includes erase
functions and
onion skinning

Enables the
capture of brushes
in the AE project
window

Paint 2D elements
on to 3D renders

Automated ‘Sticky
Pass’ plug-ins for
C4D and Maya



GPU accelerated
render engine

Full biaised
engine, which
allows for greater
flexibility

Vastly increased
render speed
compared to

CPU based
render engines

One license
comes with free
plug-ins for Maya,
and Softimage
applications

Glassworks used
the power of
Redshift to render
the Singing Babies
commercial for
Cadbury. Image
courtesy of
Glassworks

O

Redshift

$500 |

PU rendering has
revolutionised the CGI
industry over the past couple

of years. Redshift has become one of
the most talked about GPU render
solutions as it offers the flexibility of
existing CPU based render solutions,
with the speed of GPU acceleration.

The key to Redshift is that it’s a
biased render engine, meaning it
uses techniques to ‘cheat’ how the
image works — exactly the same
methodology traditional CPU based
render engines such as V-Ray use.
Unbiased engines mimic the physics
of light much more closely, meaning
comparably much longer render
times and potentially less creative
options. Until now, most popular
GPU render engines have been
unbiased, giving an exponential
render time increase. The Redshift
team have brought the grunt of the
GPU to biased rendering, and it
makes Redshift potentially one of
the fastest and full-feature render
engines on the market.

Speed means nothing if the
usability doesn’t match up. Luckily,
this isn’t the case; we tested Redshift
with Autodesk Maya 2016 (it is also

Redshift Rendering Technologies, Inc. [ WEB

If youTe used to working

with other biased engines,
Redshift is simple to get

your head around

available for 3ds Max, and Softimage
with C4D and Houdini coming) and
found it integrated well with the
host application. Dedicated Redshift
shader options, camera and render
settings were all in logical places.
Redshift supports Render proxies
well and a full set of AOVs (render
pass outputs) are available.

With IPR, Redshift allows either
bucket or progressive rendering,
which constantly updates allowing
really quick iteration during look dev.

With great tutorials on Redshift’s
site, if you’re used to working with
other biased engines, Redshift is
simple to get your head around
and easier than most to use. Basic
controls are well organised within
Maya’s render settings, or logically
placed within an object’s settings.

Www.redshift3d.coh

Redshift uses out-of-core
architecture, which uses all the
resources of the computer to render
scenes — unlike many GPU render
solutions which can only use the
memory available on the GPU,
meaning that no compromises

for scenes are required. Redshift
also uses all the memory on all the
GPUs within a PC, even if they have
different RAM amounts.

Animation and camera effects,
such as depth of field, are available
and work beautifully, which when
the samples are increased, create a
lovely rolling falloff, especially when
used with the Redshift shaders.

Redshift scales well for freelancers
or studios, as one comparatively
cheap license covers one PC, and if
that PC happens to have 12 GPUs in
it the license cost is the same as if it
had one, making it potentially more
attractive from a speed and cost point
of view than a CPU based render
solution. This is good as Redshift is
addictive, and has the potential to
become a dominant render platform
for the rest of the decade.

-

A NEW TAKE ON TRADITIONAL RENDERING

Launched in 2014, Redshift is the first render engine to mix the flexibility of biased render
engines with the power of GPU rendering. It has been used extensively in production since
its launch, and in 2016 will be releasing more plug-ins for Cinema 4D and Houdini.
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Mike Griggs
Polishing pixels since
1995, Mike is a UK
based freelance 3D,
VFX and mograph
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Issue 204
Star Wars: The Force Awakens

» Behind the scenes: ILM discuss the making of The Force Awakens

» Master the workflow for modelling ZBrush droids

» Create a photoreal character render of Boba Fett

» Discover the untold story behind the making of A New Hope
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Issue 200
The 200 greatest VFX films

» Improve your real time CG: The
game artist’s guide to VR

» Discover Epic’s 10 ways to
improve your Unreal Engine
VR movies

» Render a photoreal VR scene
from V-Ray to Samsung headset

» Master high-poly creature design

» Downloads Free software worth
$199, models, videos, setup files!
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Plus get this cover's ZBrush model!

» Weta creature modelling
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» Model the Joker: create dynamic
ZBrush illustrations
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models, video training, setup files!

» Art of Halo 5 Guardians
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» Sculpt a T-800 Arnie in ZBrush
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in ZBrush and 3ds Max

» Create organic armour in Maya

» Discover the 200 greatest VFX
films in our reader poll

» How to make a printable costume

» Downloads Free Maya eBook,
Digital-Tutors courses, models
and more!
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b Recreate an epic Game of
Thrones battle scene in 3ds Max
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textures, models and setup files!

» Master hard surface modelling
in ZBrush

» 25 essential Cinema 4D
techniques

» The VFX of Jurassic World

» How to model 3D print-ready
collectable figurines

» Graphics card review group test

» Downloads ZBrush model, video
tutorials, Substances and more!

» Professional games artists share
their work and insights

» Model a mecha character for
video games

» Create perfect run animation
cycles for games

» Master Unreal Engine 4, includes
video tutorial, models and textures

» Downloads iClone 5 worth £69,
video tutorials and project files

» 40 years of ILM, plus discover the
/NFX of Avengers: Age of Ultron

» Model Star Wars inspired
spaceships

» Master the new modelling tools
of Maya 2016

» Create an epic sci-fi environment
in Modo

» Downloads Video tutorials,
project files, resources and more!
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Issue 192
Model magical ZBrush creatures

» Create a lifelike portrait with
effective modelling & rendering

» Sculpt armour in ZBrush

» Meet Chappie: how Image
Engine brought the robot to life

» Industry experts advice for
kickstarting your career in CG

» Downloads Free book, video
tutorials, project files, resources
and more!

b Create your own VFX movie

» Master mech modelling in
Cinema 4D and ZBrush

b Star Trek interview: Pierre Drolet
talks building starships

» The ultimate guide to lighting
and rendering a complex
illustration in LightWave

» Downloads Video tutorials,
project files, resources and more

» Master the art of modelling an
anime style character

» ZBrush 4R7: why the latest
release is an essential upgrade

» Create a collectible action figure

» 10 years of CG in anime: meet
the directors who are creating
the leading 3DCG

» Downloads Video tutorials,
project files, resources and more

» Create our cover character.
Complete tutorial with video
and model!

» The ultimate guide to mastering
Maxwell Render

» Big Hero 6: discover Disney’s
latest software

» Matte painting for video games

» Downloads Video tutorials,
project files, resources and more

Zinio www.bit.

y/tdw-zinio
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Dave Morley

Image Engine’s VFX supervisor reveals how a VHS demo
of Luxo Jr got him into the industry

Dave Morley
Dave has been
involved in CG and
VEX for over 20
years, and his CV
includes Australia,
Captain America: The
First Avenger and
Unbroken. In 2014 he
was nominated for a
VES Award.
bit.ly/205-dave-morley

industry because of my love

of movies, computers and
photography. But the initial
catalyst? Many years ago I was
working in a photographic studio
printing 35mm film slides for things
like PowerPoint presentations.
I worked with a huge variety of
software packages, as people sent
files to us in all different formats.

One day a box arrived with some

new software from a company
T’d never heard of: Pixar. The
software was called Typestry,
and it was a small program that
could be used to create 3D type.
Along with the software was a
VHS tape marked ‘Luxo Jr’. T was
curious. I took it home, put it in
the machine and bam! - I was hit
by a sledgehammer. I was gone,
hook line and sinker, and without
knowing it at the time, my
journey had begun.

I wanted to get into the VFX

We had a copy of 3d Studio, so T
started modelling and lighting.
Admittedly they were really
terrible at the time, being as I
was teaching myself, but I kept

at it. A good friend of mine

was a producer at a local VFX/
design house in Sydney called
Garner MacLennan Design. As it
happened, they were looking for a
junior 3D artist to join their team.
Fortunately, they didn’t require
formal training as it simply didn’t
exist at the time! I got the job and
haven’t looked back since!

If I had to share just one ‘wow’
moment, it would have to be
working with Frank Miller. I had
worked indirectly with Frank
on his film adaptation of The
Spirit. Through that, I had the
opportunity to work with him
again on a Gucci commercial.

I flew to Rome from Australia
for the filming, and after a good

20 hours of travel I was whisked
off to a room in the studio, and
it was there that I met Frank
in person for the first time. He
started to draw storyboards to
explain some of his thoughts -
I was jet lagged and very tired,
so it was a totally surreal
moment. He was a hero of mine
of sorts, and I’d loved his work
for a long time prior to working
with him. So, sitting there
watching Frank Miller put
pencil to paper was a really
significant moment for me.

See more of Dave’s work at

www.image-engine.com

Pixar's Luxo Jr
was the catalyst
for Dave Morley's
VFX career
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